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1.1

About this document

Other applicable documents

Leuze

The information on the safety sensor is distributed over several documents to make working with the docu-
ments easier. You will find the documents and software for the safety sensor in the following table:

Tab. 1.1: Other applicable documents

Purpose and target group of the document

Document/software ti-
tle

Source

Software for machine users @ for diagnosing the
safety sensor in the event of a fault and for machine
designers for configuring the safety sensor

Sensor Studio DTM RSL
200 (collection of safety
devices)

Leuze website, on the
product page of the de-
vice under the Down-

loads tab

Notes for the machine design engineer 2 Operating instructions

RSL 200 (this document)

Online help for software

Notes for the machine design engineer 2 for config-
uring the safety sensor (software instructions)

RSL 400 / RSL 200 UDP
specification

Notes for the design engineer on the use of UDP
data telegrams

User instructions RSL
200

3 Machine identifies the product that the safety sensor is installed in.

Notices regarding mounting, alignment and connec-
tion of the safety sensor

Print document, supplied
with the safety sensor

1.2 Download configuration and diagnostic software from the Internet
% Call up the Leuze website: www.leuze.com.
% Enter the type designation or part number of the device as the search term.

% The configuration software can be found on the product page for the device under the Downloads tab.

1.3 Used symbols and signal words

Tab. 1.2: Warning symbols and signal words

Symbol indicating dangers to persons

Symbol indicating dangers from harmful laser radiation

Symbol indicating possible property damage

e B b

NOTE Signal word for property damage

Indicates dangers that may result in property damage if the measures for dan-
ger avoidance are not followed.

CAUTION Signal word for minor injuries

Indicates dangers that may result in minor injury if the measures for danger
avoidance are not followed.

WARNING Signal word for serious injury

Indicates dangers that may result in severe or fatal injury if the measures for
danger avoidance are not followed.

DANGER Signal word for life-threatening danger

Indicates dangers with which serious or fatal injury is imminent if the measures
for danger avoidance are not followed.

Leuze electronic GmbH + Co. KG RSL210 6
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Tab. 1.3: Other symbols

Symbol for tips
0 Text passages with this symbol provide you with further information.

Symbol for action steps
% Text passages with this symbol instruct you to perform actions.

Symbol for action results

= Text passages with this symbol describe the result of the preceding action.
Tab. 1.4: Terms and abbreviations
CS Switching signal from a control
(Controller Signal)
DTM Software device manager of the safety sensor
(Device Type Manager)
EDM Contactor monitoring
(External Device Monitoring)
FDT Software frame for management of device managers (DTM)
(Field Device Tool)
Field triple One protective field with two associated warning fields
AGV Automated Guided Vehicle
LED LED, display element in the safety sensor
(Light Emitting Diode)
OSSD Safety-related switching output
(Output Signal Switching Device)
PELV Protective extra-low voltage
(Protective Extra Low Voltage)
PFH, Probability of a dangerous failure per hour
(Probability of dangerous Failure per Hour)
PL Performance Level
RES Start/restart interlock
(Start/REStart interlock)
SIL Safety Integrity Level
State ON: ON: device intact, OSSDs switched on
OFF OFF: device intact, OSSDs switched off
Lock Locking: device, connection or actuation/operation faulty, OSSDs
switched off (lock-out)

1.4 Checklists

The checklists are used as a reference for the machine manufacturer or equipment supplier (see chapter
10 "Testing"). They do not replace the inspection of the entire machine or system before the first start-up,
nor their regular inspections by a qualified person (see chapter 2.3 "Competent persons"). The checklists
contain minimum testing requirements. Depending on the application, other tests may be necessary.

Leuze electronic GmbH + Co. KG RSL210 7
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Safety

Before using the safety sensor, a risk assessment must be performed according to valid standards (e.g.
EN ISO 12100, EN I1SO 13849-1, IEC/EN 61508, EN IEC 62061). The result of the risk assessment deter-
mines the required safety level of the safety sensor (see chapter 14.1 "Safety-relevant technical data"). For
mounting, operating and testing, this document as well as all applicable national and international stan-
dards, regulations, rules and directives must be observed. Relevant and supplied documents must be ob-
served, printed out and handed to affected persons.

% Before working with the safety sensor, completely read and observe the documents applicable to your
task.

In particular, the current version of the following national and international legal regulations apply for com-
missioning, technical tests and handling of safety sensors:

* Machinery directive
* Low voltage directive
 Electromagnetic Compatibility Directive

 Directive on the restriction of the use of certain hazardous substances in electrical and electronic equip-
ment

« OSHA
» Safety regulations
» Accident-prevention regulations and safety rules

« Ordinance on Industrial Safety and Health and employment protection act
* Product Safety Law (ProdSG)

For safety-related information you may also contact local authorities (e.g., industrial inspec-
torate, employer's liability insurance association, labor inspectorate, occupational safety and
health authority).

Intended use

The safety sensor protects persons or body parts at points of operation, danger zones or access points of
machines and systems.

A running machine may result in serious injury!

% Make certain that the safety sensor is correctly connected and that the protective function of
the protective device is ensured.

% Make certain that, during all conversions, maintenance work and inspections, the system is
securely shut down and protected against being restarted.

» The safety sensor must only be used after it has been selected in accordance with the respective valid
instructions and relevant rules, standards and regulations on occupational safety and safety at work,
and installed, connected, commissioned and tested by a competent person on the machine ( see chap-
ter 2.3 "Competent persons").

* When selecting the safety sensor, it must be ensured that its safety-related performance capability is
greater than or equal to the required performance level PL, determined in the risk assessment (see
chapter 14.1 "Safety-relevant technical data").

» The safety sensor may only be used in North America in applications that satisfy the requirements
specified by NFPA 79.

» The construction of the safety sensor must not be altered. When manipulating the safety sensor, the
protective function is no longer guaranteed. Manipulating the safety sensor also voids all warranty
claims against the manufacturer of the safety sensor.

» The safety sensor must be inspected regularly by a competent person to ensure proper integration and
mounting (see chapter 14.1 "Safety-relevant technical data").

Leuze electronic GmbH + Co. KG RSL210 8
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/N\ CAUTION

Observe intended use!

The protection of personnel and the device cannot be guaranteed if the device is operated in a
manner not complying with its intended use.

% Only operate the device in accordance with its intended use.
% Leuze electronic GmbH + Co. KG is not liable for damages caused by improper use.

% Read these operating instructions before commissioning the device. Knowledge of the oper-
ating instructions is an element of proper use.

NOTICE

Comply with conditions and regulations!
% Observe the locally applicable legal regulations and the rules of the employer's liability insur-

ance association.

Airborne particles

Vapors, smoke, dust and all particles visible in the air can cause the machine to switch off unintentionally.
This can mislead the user into bypassing the safety devices.

% Do not use the safety sensor in environments in which heavy vapors, smoke, dust or other visible parti-
cles occur at the beam level.

Stray light
Light sources can impair the safety sensor's availability. Interfering light sources are:
* Infrared light
* Fluorescent light
« Strobe light
% Ensure that there are no interfering light sources at beam level.
% Prevent reflective surfaces at beam level.
% Where applicable, take protective field addition distances into account.

% Implement all additional measures to ensure that any special application of any effected beam types
does not impair the safety sensor's operation.

Obstructions in the protective field

% Do not bring any additional window materials into the area monitored by the safety sensor.

No screen between optics cover and monitoring area!
% Between the optics cover of the safety sensor and the monitored area, no further screen

may be mounted to protect the safety sensor.

Foreseeable misuse

Any use other than that defined under "Intended use" or which goes beyond that use is considered im-
proper use.

In principle, the safety sensor is not suitable as a protective device for use in the following cases:

« Danger posed by ejected objects or the spraying of hot or hazardous liquids from within the danger
zone.

» Applications in explosive or easily flammable atmospheres.
» Use for outdoor applications or under extreme temperature fluctuations.

Humidity, condensation and other weather influences can impair the protective function.
» Use on vehicles with combustion engines.

Alternators and ignition systems can cause EMC interferences.

Leuze electronic GmbH + Co. KG RSL210 9
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NOTICE

0 Do not modify or otherwise interfere with the safety sensor!

% Do not carry out modifications or otherwise interfere with the safety sensor. The safety sen-
sor must not be tampered with and must not be changed in any way.

% The safety sensor must not be opened. There are no user-serviceable parts inside.

% The construction of the safety sensor must not be altered. WWhen manipulating the safety
sensor, the protective function is no longer guaranteed.

% Manipulating the safety sensor voids all warranty claims against the manufacturer of the
safety sensor.

% Repairs must only be performed by Leuze electronic GmbH + Co. KG.

2.3 Competent persons

Connecting, mounting, commissioning and adjustment of the safety sensor must only be carried out by
competent persons.

Prerequisites for competent persons:
* They have a suitable technical education.

» They know the rules and regulations for labor protection, safety at work and safety technology and can
assess the safety of the machine.

» They know the operating instructions for the safety sensor and the machine.

» They have been instructed by the responsible person on the mounting and operation of the machine
and of the safety sensor.

* You are currently employed in a role related to the subject of the audit.
Task-specific minimum requirements for suitably qualified persons:
Configuration

Specialist knowledge and experience in the selection and use of protective devices on machines as well as
the application of technical rules and the locally valid regulations on labor protection, safety at work and
safety technology.

Mounting

Specialist knowledge and experience needed for the safe and correct installation and alignment of the
safety sensor with regard to the respective machine.

Electrical installation

Specialist knowledge and experience needed for the safe and correct electrical connection as well as safe
integration of the safety sensor in the safety-related control system.

Electrical work must be carried out by a certified electrician. Due to their technical training, knowledge and
experience as well as their familiarity with relevant standards and regulations, certified electricians are able
to perform work on electrical systems and independently detect possible dangers. In Germany, certified
electricians must fulfill the requirements of accident-prevention regulations DGUV (German Social Accident
Insurance) provision 3 (e.g. electrician foreman). In other countries, there are respective regulations that
must be observed.

Operation and maintenance

Specialist knowledge and experience needed for the regular inspection and cleaning of the safety sensor —
following instruction by the person responsible.

Servicing

Specialist knowledge and experience in the mounting, electrical installation and the operation and mainte-
nance of the safety sensor in accordance with the requirements listed above.

Commissioning and testing

+ Commissioning and testing: experience and specialist knowledge in the rules and regulations of labor
protection, safety at work and safety technology that are necessary for being able to assess the safety
of the machine and the use of the safety sensor, including experience with and knowledge of the mea-
suring equipment necessary for performing this work.

Leuze electronic GmbH + Co. KG RSL210 10
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2.6

Leuze

 In addition, an activity in the environment of the object of the inspection is carried out in a timely man-
ner and the person's level of knowledge is kept up to date through continuous training in the latest tech-
nology — a “qualified person” as defined by the German Industrial Safety Regulation and other national
legal requirements.

Disclaimer
Leuze electronic GmbH + Co. KG is not liable in the following cases:
* The safety sensor is not used as intended.
» Safety notices are not adhered to.
* Reasonably foreseeable misuse is not taken into account.
* Mounting and electrical connection are not properly performed.
» Proper function is not tested (see chapter 10 "Testing").
* Changes (e.g., constructional) are made to the safety sensor.

Laser safety notices

Laser class 1 for wavelength range outside 400 - 700 nm

NOTICE

0 Additional measures for shielding the laser radiation are not necessary (safe for eyes).

A

7'\

LASER RADIATION - CLASS 1 LASER PRODUCT

The device satisfies the requirements of IEC 60825-1:2014 / EN 60825-1:2014+A11:2021 safety
regulations for a product of laser class 1 and complies with 21 CFR 1040.10 except for confor-
mance with IEC 60825-1 Ed. 3., as described in Laser Notice No. 56, dated May 8, 2019.

% Observe the applicable statutory and local laser protection regulations.

% The device must not be tampered with and must not be changed in any way.
There are no user-serviceable parts inside the device.
CAUTION! Opening the device may result in hazardous radiation exposure!
Repairs must only be performed by Leuze electronic GmbH + Co. KG.

Responsibility for safety

Manufacturer and operator must ensure that the machine and implemented safety sensor function properly
and that all affected persons are adequately informed and trained.

The type and content of all imparted information must not lead to unsafe actions by users.
The manufacturer of the machine is responsible for:
« Safe machine construction and information on any residual risks

» Safe implementation of the safety sensor, verified by the initial test performed by a competent person
(see chapter 2.3 "Competent persons")

* Imparting all relevant information to the operating company

» Adhering to all regulations and directives for the safe commissioning of the machine
The operator of the machine is responsible for:

* Instructing the operator

» Maintaining the safe operation of the machine

» Adhering to all regulations and directives for labor protection and safety at work

* Regular inspection by authorized persons (see chapter 2.3 "Competent persons")

Leuze electronic GmbH + Co. KG RSL210 11
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3.1

Device description

Protective function

The RSL 200 safety laser scanner is an active optoelectronic protective device (AOPD) that is used to pro-
tect people or body parts at points of operation, in hazardous areas or at access points to machines and
systems.

The safety laser scanner contains a rotating mirror that deflects periodically transmitted light pulses,
thereby scanning the surrounding area in two dimensions. The light pulses are scattered in all directions by
obstacles, e.g. persons. A part of the light pulses is received again by the safety sensor and evaluated. The
safety sensor calculates the precise position of the object from the propagation time of the radiated light
and the current angle of the deflection unit at that time. If the object is within a predefined area, the protec-
tive field, the safety sensor performs a safety-related switching function. It switches the safety-related
switching outputs off. Only when the protective field is free again does the safety sensor reset the safety-re-
lated switching function, either automatically or following acknowledgment, depending on the operating
mode. The safety sensor can even detect people wearing very dark clothing with a very low reflectivity
(>1.8%).

The angular resolution, i.e. the angular distance between two distance measurement values, is 0.2° for the
RSL 200 series safety laser scanners and objects in the scanning range of up to 275° are detected, de-
pending on which monitoring area is configured.

-137,5°

==Y
)

137,5° /

20°
1 Angular resolution 0,2°
Fig. 3.1: Light pulses scan an area

The following parameters for switching off the safety-related switching outputs of the safety sensor are
taken into consideration for the protective function:

» Configurable protective fields
« Configurable field triple switchover
» Selectable resolution for leg detection
» Safety sensor response time
» Selectable start-up behavior
The following non-safety-oriented functions and signals also belong to the protective function:
» Configurable warning fields
» Configurable indication signals
Additional functions of the protective function
* Warning field evaluation
» Selectable dynamic contactor monitoring (EDM)

Leuze electronic GmbH + Co. KG RSL210 12
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3.2

Device overview

The safety sensors from the RSL 200 series are optoelectronic, two-dimensional measuring safety laser
scanners. They satisfy the following standards:

Tab. 3.1: Safety features

Standardization RSL 200
Type in accordance with EN IEC 61496 3
Category in accordance with EN ISO 13849-1

Safety Integrity Level (SIL) in accordance with IEC/EN 61508
Maximum SIL in accordance with EN IEC 62061
Performance Level (PL) in accordance with EN ISO 13849-1

O IN[IN|W

1 Optics cover

2 LED indicator

3 USB connection type C (behind protection cap)

Fig. 3.2: Device overview of RSL 200 safety laser scanners

All safety sensors in the RSL 200 series are equipped with the following features:

» Switchable protective/warning field triple consisting of one configurable protective field and two config-
urable warning fields. The number of switchable protective/warning field triples is variant-dependent.

* Number of OSSD pairs: 1

» Laser scanner with the range class S (3,00 m)

« LED indicator

* Bluetooth interface

* USB interface

« Configuration memory

 Electrical connection to the machine via connection cable

% Use the USB connection only temporarily for configuration or diagnosis of the safety sensor.

% For permanent connection, connect the safety sensor to the Ethernet connection of the con-
nection unit. (RSL 230, RSL 235)

% Unused USB lines must not be permanently connected to the safety sensor.

The following table provides an overview of the variant-dependent features and functions of the RSL 200
safety sensors.

Leuze electronic GmbH + Co. KG RSL210 13
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3.3

3.31

Tab. 3.2: Features and functions
Feature/function RSL 210 |RSL220 |RSL 230 |RSL 235
Ethernet connection - - X X
Configurable signal outputs Upto4 Upto4 Upto 8 Upto8
Number of switchable protective/warning field pairs 1 8 32 32
Measurement data output optimized for vehicle navi- |- - - X
gation

Device connections

The safety laser scanners of the RSL 200 series are each equipped with a rotatable M12 connector for the
power supply, OSSDs and universal I/Os (can be used as a universal input or universal output), which dif-
fers in the number of pins depending on the device model.

Tab. 3.3: Device connections
Device model Connection
RSL 210 M12 connector, 8-pin, A-coded

To ensure the IP protection and leak tightness of the devices, the supplied protection caps must
always be placed on unused connections.

USB connection
The safety sensor has a USB port as a service interface for configuration and diagnostics. The USB port
complies with the 2.0 Type C standard.

NOTICE

% Use the USB connection only temporarily for configuration or diagnosis of the safety sensor.

% For permanent connection, connect the safety sensor to the Ethernet connection of the con-
nection unit. (RSL 230, RSL 235)

% Unused USB lines must not be permanently connected to the safety sensor.

NOTICE

0 % After use, seal the USB connection using a protection cap. Make sure that the protection

cap is felt to engage when sealing. The IP degree of protection specified in the technical
data is only achieved when the protection cap is closed.

Leuze electronic GmbH + Co. KG RSL210 14
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3.3.2 Configuration memory

The safety sensor has a replaceable configuration memory on the underside of the device. This is used to
store the configuration files and automatically transfers the stored parameters when devices are replaced
(see chapter 12.1 "Replacing the device").

1 Configuration memory
2 Cross-head screw M3

Tightening torque 0.35 - 0.5 Nm

Fig. 3.3: Position of the configuration memory

34 Bluetooth

The safety sensor has an integrated Bluetooth interface for transmitting diagnostic data to a PC or mobile
device.

The RSL 200 app provided by Leuze is required for reading out the diagnostic data and status and error in-

formation on a mobile device (see chapter 11.2 "Diagnostic displays RSL 200 app").
The integrated Bluetooth interface is intended for temporary use.

3.5 Display elements
The display elements of the safety sensors simplify start-up and fault analysis.

LED indicator
Five status LEDs are located below the optical hood.

LR OO

LED 1, red/green
LED 2, yellow

LED 3, blue

LED 4, blue/green
LED 5, yellow/green

a b~ ON -

Fig. 3.4: LED indicator

Leuze electronic GmbH + Co. KG RSL210
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Tab. 3.4: LED indicator
LED Color State Description
1 Red/green OFF Device switched off
Red OSSD off
Red, flashing * Error
» Device starting up
Green OSSD on
2 Yellow OFF * RES deactivated
* RES activated and enabled
Yellow flashing Protective field occupied
ON RES activated and blocked but ready to be un-
locked
3 Blue OFF All warning fields are empty
Blue, flashing Two warning fields are interrupted
ON A warning field is interrupted
4 Blue/ green OFF Bluetooth deactivated
Blue, flashing Bluetooth activated, active connection to external
device
Blue Bluetooth activated
Green, flashing (30 s) Ping received via Sensor Studio
5 Yellow/ green |OFF No contamination warning / no contamination error
Yellow flashing Contamination warning (OSSD ON)
Yellow Contamination error (OSSD OFF)
Green, flashing (30 s) Ping received via Sensor Studio
All 1: Red ON (4 s) Supply voltage applied. Device starting up
2: Yellow
3: Blue
4: Green
5: Green
3.6 Field types

The safety laser scanner continuously checks whether persons or objects are located in one or several
fields. The following field types are distinguished:

Leuze electronic GmbH + Co. KG

Protective field

The protective field secures the danger zone of a machine or vehicle. If an object is within the protective
field, the safety sensor carries out a safety-related switching function and switches off the safety-related

switching outputs (OSSDs). Downstream control elements can use this signal to end the dangerous state.

Only when the protective field is free again does the safety sensor reset the safety-related switching func-
tion, either automatically or following acknowledgment, depending on the operating mode.

Warning field

The warning field must not be used in safety-related applications. It is used to generate simple switching
functions such as visual or audible warning signals before the protective field is violated.

RSL210
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Tab. 3.5: Features protective field and warning field
Feature Protective field Warning field

(degree of reflectance: 1.8 %

(degree of reflectance: 20.0

Safe shutdown (according to EN
ISO 13849-1)

Yes (PL d)

No

Max. Address of the safety laser
scanner.

3.0m

15,0m

Intended use

Recognition and protection of per-
sons

 Application-specific use (e.g.
visual or audible warning sig-
nal)

* Not a safety-related use

Leuze electronic GmbH + Co. KG
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41

Functions

The functions of the safety sensor must be matched to the respective application and its safety require-
ments. You can activate/deactivate the functions and adapt them using parameters. You configure the
functions using the configuration and diagnostics software (see chapter 8.2 "Configuring the safety sen-
sor").

» You configure the functions of the safety sensor in the software as configuration projects.

* In each configuration project you determine the protective function and the configurable field pairs via
the selected function mode.

* You determine the resolution, the start-up behavior, the response time and, where applicable, the vehi-
cle speed together for all protective/warning field pairs of a configuration bank.

Authorization concept of safety sensor

User management allows target-group-oriented communication between the software and the safety sen-
sor. Which functions are available depends on the selected access level of the user. For information on
the software and user administration (see chapter 8.1 "Configuration and diagnostics software - Sen-

sor Studio").

» Changing the safety configuration as well as the communication and diagnostics settings of the sensor
is only permitted for certain access levels.

« Installation and operation of the software do not depend on the access level of the user.
The following access levels are available:

Tab. 4.1: Access levels and functions available
Access level Functions
Observer » Display the measurement contour

» Upload and display configuration data from the safety sensor
 Display status information from the safety sensor

» Display diagnostics list

» Customize display

« Display and evaluate the measurement contour

 Load configuration data from the safety sensor

» Load status information from the safety sensor

» Create service file

* Reset password

Expert In addition to the functions of the Observer

» Load the signed safety configuration from a file and transfer/download to
the safety sensor

» Transfer changed communication and diagnostics settings from the PC to
the safety sensor

 Print configuration data incl. protective/warning fields

» Calibrate optics cover

Leuze electronic GmbH + Co. KG RSL210 18



Functions Leuze

4.2

Access level Functions

Engineer In addition to the functions of the Expert, full access to all user-relevant func-
tions and parameters:

Create and change a safety configuration:
» Save configuration data to file
» Change all parameters of configuration
* Reset safety sensor to default values
» Define and change protective/warning fields
» Print and delete protective/warning fields
» Load protective/warning field data from file
» Save protective/warning field data
» Transfer protective/warning field data from the PC to the safety sensor

» Change passwords

The software saves individual passwords in the connected safety sensor, thereby ensuring that
only authorized users can change the existing configuration.

Determining access level

When creating a user in the user management via Tools > User management in the FDT frame menu, se-
lect the access level for the user. In the user management you can also create and change passwords for
the users.

Using the device manager (DTM) you can change the access level of the user, if necessary (see chapter
8.1.6 "Selecting access level").

Click in the DTM menu bar on the [Change authorization level].

Function modes of safety sensor

You configure the functions of the safety sensor in configuration projects with the help of the configuration
and diagnostics software. In each configuration project you determine the protective function and the con-
figurable field pairs via the selected function mode.

Select the function mode of the safety sensor in the software device manager (DTM) with CONFIGURA-
TION > FIELD CONFIGURATIONS (see chapter 8.2 "Configuring the safety sensor").

You use the protective function to define the criteria for switching off the safety-related switching outputs.

Tab. 4.2: Function mode

Device model field triple/protective fields |Field triple activation
warning fields

RSL 210 1 field triple Fixed selection of a field triple
1 protective field + 2 warning
fields

The safety sensor monitors a protective field and up to two warning fields simultaneously. Depending on
the model, a fixed triple field or up to 32 switchable triple fields are monitored.

Leuze electronic GmbH + Co. KG RSL210 19
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4.3

4.4

4.5

@
(1) FxP

@ Fxwi
3 Fxw2

1 Protective field
2 Warning field 1
3 Warning field 2

Fig. 4.1: One protective field with two warning fields
If the protective field is violated, the safety-related switching outputs (OSSDs) switch to OFF.

The assignment of the signals that are generated when a warning field is violated to the switching outputs
is done via the configuration and diagnostics software (CONFIGURATION > Signal parameter; see chap-
ter 8.2 "Configuring the safety sensor").

Selectable resolution for leg detection

The application-specific resolution of the safety sensor is defined in the configuration project together for all
protective/warning field pairs of a configuration bank.

Tab. 4.3: Resolution of the safety sensor depending on the function

Safety sensor res- | Function Application

olution (mm)

50 mm Leg detection with the safety sensor Stationary protection of hazardous areas
mounted close to floor level

70 mm Leg detection with the safety sensor » Stationary protection of hazardous
mounted at a height of 300 mm areas
» Danger zone safeguarding

Mounting height = Height of the scan level above floor level

Speed-dependent protective function for vehicles

For object detection in the case of mobile applications, the safety sensor evaluates the relative speed of the
object. If the safety sensor is mounted on vehicles or on moving parts of machines, the maximum speed of
the vehicle must be entered during configuration of the protective function.

The maximum vehicle speed (Max. AGV speed) is selected in the configuration project together for all pro-
tective/warning field pairs of a configuration bank.

Response time

The response time is the maximum time from a protective field violation to switch-off of the safety-related
switching outputs.

The response time is selected in the configuration project for all protective/warning fields together.
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4.6

4.6.1

4.6.2

Configurable start-up behavior
The start-up behavior is selected in the configuration project for all protective/warning fields together.

Automatic start/restart

The safety sensor switches the OSSDs to the ON state as soon as the machine is turned on or the power
supply is restored and when the protective field is cleared again.

Using automatic start/restart

You can use the automatic start/restart function under the following prerequisites:

» The start/restart interlock function is taken over by a downstream safety-related component of the ma-
chine control system.

or:
* Itis not possible to walk behind or go around the effective protective field.
% Allow for an optical and/or acoustic start warning.

Automatic start-up
The automatic start-up function starts the machine automatically as soon as the supply voltage is present.

Automatic restart
The automatic restart function starts the machine automatically as soon as the protective field is free again.

Start interlock/automatic restart

With start interlock/automatic restart, the safety sensor remains in the OFF state when, following a power
supply interruption, the voltage supply is restored. After violation of the protective field, the system restarts
when the protective field is free again.

The start/restart interlock has two functions:
e Start interlock

¢ Automatic restart

Using start interlock/automatic restart

% In addition to the safety sensor you must also install the reset button. The machine operator starts the
machine with this reset button.

% Position the reset button outside the danger zone so that it cannot be activated from the protective
fields and danger zones. The operator must be able to see all danger zones from this position.

% Identify the area to be released on the reset button so that its meaning is clear and easy to understand.
% Ensure that nobody is in the danger zone before pressing the reset button.
% Hold down the reset button for between 0.12 s and 4 s to enable the safety-related switching outputs.

A DANGER

Risk of death if start-up is operated unintentionally!

% Ensure that the reset button for unlocking the start interlock cannot be reached from the
danger zone.

% Before unlocking the start interlock, make certain that no people are in the danger zone.

Start interlock

The start interlock function prevents the machine from starting automatically after switching on or after the
supply voltage returns.

The machine only starts when you press the reset button.

Automatic restart
The automatic restart function starts the machine automatically as soon as the protective field is free again.
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4.6.3

4.7

Start/restart interlock (RES)

When accessing the protective field, the start/restart interlock ensures that the safety sensor remains in the
OFF state after the protective field has been cleared. It prevents automatic release of the safety circuits
and automatic start-up of the system, e.qg. if the protective field is again clear or if an interruption in the volt-
age supply is restored.

The start/restart interlock has two functions:
« Start interlock
* Restart interlock

For access guarding, the start/restart interlock function is mandatory. The protective device may
only be operated without start/restart interlock in certain exceptional cases and under certain
conditions acc. to EN ISO 12100.

Using start/restart interlock

% In addition to the safety sensor you must also install the reset button. The machine operator starts the
machine with this reset button.

% Position the reset button outside the danger zone so that it cannot be activated from the protective
fields and danger zones. The operator must be able to see all danger zones from this position.

% Identify the area to be released on the reset button so that its meaning is clear and easy to understand.
% Ensure that nobody is in the danger zone before pressing the reset button.
% Hold down the reset button for between 0.12 s and 4 s to enable the safety-related switching outputs.

Risk of death if start/restart is operated unintentionally!

% Ensure that the reset button for unlocking the start/restart interlock cannot be reached from
the danger zone.

% Before unlocking the start/restart interlock, make certain that no people are in the danger
zone.

Start interlock

The start interlock function prevents the machine from starting automatically after switching on or after the
supply voltage returns.

The machine only starts when you press the reset button.

Restart interlock

The restart interlock function prevents the machine from starting automatically, as soon as the protective
field is free again. The restart interlock function always includes the start interlock function.

The machine only starts again when you press the reset button.

Field triple changeover

Depending on the model, the safety sensor has 1 (RSL 210), 8 (RSL 220) or 32 (RSL 230, RSL 235)
switchable field triples. With the models with 8 or 32 switchable field triples, it is possible to switch between
the field triples at any time, as far as the operating situation allows.

Use the field pair changeover when the danger zones vary depending on the activity of the machine or the
operating state, e.g. automated guided vehicles (AGVs), to control the field pair changeover for straight and
curved stretches.

If the rules for field pair changeover are not complied with, the safety sensor signals a fault and the safety-
related switching outputs are switched off.

The safety sensor has the following modes for field pair activation and field pair changeover:
» Fixed selection of a field triple
+ Selection by signal inputs with fixed switchover time

The field triple switchover can be monitored by configurable measures (see chapter 4.8 "Monitoring the
field triple switchover").
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During the switchover process the safety sensor monitors the field triple activated before the field triple
switchover according to the configured switchover time.

Using field triple switchover

You can configure and switch the field triples according to the different requirements. Switching is via the
correspondingly configured control inputs.

The rules of the field triple switchover depend on the switchover time. The activated field pair must corre-

spond with the respective operating mode. The time of the field pair changeover must correspond with the
machine's risk assessment. You must take the lead time, braking distances, response times and machine
stopping times, e.g. influenced by overlapping protective fields, into account.

If the requirements on the time behavior of the field pair changeover are not maintained, the safety-related
switching outputs switch off and a message is displayed (see chapter 11 "Diagnosis and troubleshooting").

The following rules apply to the field triple switchover:

» The field pair changeover performed by the control system must agree with the safety sensor's configu-
ration. This configuration is set using the configuration and diagnostics software (see chapter 8.2.4
"Configuring protective function").

* In the case of field pair changeover with fixed changeover time to an occupied protective field, the
safety sensor switches off the safety-related switching outputs only after the sum of the synchronization
time of 25 ms, the set changeover time and the set response time.

Example of protective field switchover — Point of operation G1 and G2 with immediate switchover or
time overlap:

The machine has 2 points of operation (G1 and G2). Each point of operation is safeguarded by a protective
field (SFa and SFb). Initially, point of operation G1 is active and protective field SFa is selected. If the ma-
chine now switches directly from G1 to G2, a further protective field SFc must be interposed, covering the
areas SFa and SFb in a suitable manner.

Gl G2

Fig. 4.6: Arrangement of points of operation and protective fields

The field pair changeover from SFa to SFc takes place at time TO, whereby TO must be Tv before activa-
tion of point of operation G2 (danger G2 begins as of Tx). The time Tv is derived from the risk assessment
for the machine and from the rules governing field pair changeover and must be selected such that point of
operation G2 can be shut down in good time.

The field pair changeover from SFc to SFb may take place at time TO1 = Tz minus the set changeover time
at the earliest (danger G1 persists until Tz).
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Fig. 4.7: Protective field switchover at 2 points of operation

Fixed selection of a field triple

If Fixed selection of one field pair is set as the mode for field pair activation, field pair F1.1 is monitored
irrespective of how the control inputs are connected.

Monitoring the field triple switchover

The Switchover Order function specifies the permissible field triple switchovers, e.g. if it is mandatory to
switch from field triple F2 to field triple F5. If the Monitoring the Field Triple Switchover function is activated,
the safety-related switching outputs (OSSDs) switch off in the following cases:

» The control initiates an unauthorized field triple switchover.
» The field triple to which the switchover is made has been deactivated.

Activating the function

% Define the switchover sequence with the configuration and diagnostics software (Defining permissible
field pair changeovers).

Field triple monitoring

With the Field triple monitoring function, you can define the monitoring mode for the selected field triple.
With the Standby request monitoring mode, you can switch off the field triple monitoring and the safety-re-
lated switching outputs (OSSDs). This is advisable when parking vehicles, for example.

Activation of the function

% Activate the field triple monitoring in the configuration and diagnostics software (see chapter 8.2.4
"Configuring protective function").

EDM contactor monitoring

The EDM contactor monitoring function dynamically monitors the contactors, relays or valves connected
downstream of the safety sensor. Prerequisite for this are switching elements with positive-guided feedback
contacts (normally closed contacts).

Activation of the function

% Activate the contactor monitoring function using the configuration and diagnostics software (see chap-
ter 8.2.4 "Configuring protective function").

If contactor monitoring is activated, it operates dynamically, i.e., in addition to monitoring the closed feed-
back circuit every time before the OSSDs are switched on, it also checks whether the feedback circuit has
opened within 500 ms after release and whether it has closed again within 500 ms after the OSSDs
switched off. If this is not the case, the OSSDs return to the OFF state after being switched on briefly.

The safety sensor goes into the fault lock state:
» With the OSSDs switched off, +24 VV must be present at the EDM input.
» With the OSSDs switched on, the EDM circuit must be open (high impedance).

Leuze electronic GmbH + Co. KG RSL210 24



Functions Leuze

411 Signaling functions

The device and monitoring functions of the safety sensor deliver indication signals for the following function
groups:

» Protective functions, e. g,
* Protective field violated
» Warning field violated
* Device functions
* Error messages
» Warnings
» Diagnosis

The assignment of the individual functions within the function groups to the indication signals is defined us-
ing the configuration and diagnostics software (see chapter see chapter 8.2.5 "Configuring signal outputs").
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5 Applications
The following chapters essentially describe the safety sensor's usage possibilities.
» To safely mount the safety sensor for the respective application, see chapter 6 "Mounting”.
» For the electrical connection of the safety sensor, see chapter 7 "Electrical connection”.

» To safely configure the safety sensor for the respective application, see chapter 8.2 "Configuring the
safety sensor".

5.1 Stationary danger zone guarding

Stationary danger zone guarding enables a very spacious protection of people on machines that are to re-
main as accessible as much as possible. The safety sensor is applied as a stop-activating and presence-
detecting protective device. The safety sensor's protective field is set up horizontally in front of the machine
or system's point of operation.

You can also use the stationary danger zone guarding if you do have to guard areas under the machine or
at the rear that are not visible.

If the danger zone changes during operation, the respective danger zone is guarded by means of a field
pair changeover while the working area is accessible.

1 Safety sensor
2 Danger zone, protective function activated

Fig. 5.1: Stationary danger zone guarding
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5.2 Mobile danger zone guarding

The mobile hazard zone guarding protects people who are in the path of an automated guided vehicle sys-
tem (AGVS), cranes, forklifts or transfer cars. The distance between the protective field front edge and the
vehicle front must be greater than the stopping distance of the vehicle with selected speed and maximum
load. A safe control system selects speed-dependent protective fields and can activate side horizontal pro-
tective fields for curved stretches.

1 Safety sensor

2 Protective field

3 Warning field 1

4 Warning field 2

Fig. 5.2: Mobile danger zone guarding
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6.1

Mounting

The safety sensor's protective function is only guaranteed when the device arrangement, configuration,
protective field dimensioning and mounting are coordinated with the respective application.

The installation work must only be performed by a competent person in compliance with the applicable
standards and these instructions. The mounting must be thoroughly inspected on completion.

% Observe the relevant machine-specific standards and regulations (see chapter 16 "Standards and legal
regulations").

% Observe the basic instructions for assembly (see chapter 6.1 "Basic infos").

Improper mounting may result in serious injury!

\ | The protective function of the safety sensor is only ensured if appropriately and professionally
mounted for the respective, intended area of application.

% Only allow competent persons to install the safety sensor.

% Observe the necessary safety distances (see chapter 6.1.1 "Calculation of safety dis-
tance S").

% Make sure that stepping behind, crawling under or stepping over the protective device is reli-
ably ruled out and reaching under, over or around is taken into account in the safety dis-
tance, if applicable with additional distance Cr, corresponding to EN ISO 13855.

% Mount the safety sensor in such a way that it is protected from being damaged.

% If the vibration and shock requirements are above the values specified in this document, vi-
bration damping measures must be implemented.

% Take measures to prevent that the safety sensor can be used to gain access to the danger
zone, e.g. by stepping or climbing into it.

% Observe the relevant standards, regulations and these instructions.
% After mounting, check the safety sensor for proper function.

% Clean the safety sensor at regular intervals.
Environmental conditions: see chapter 14 "Technical data"
Care: see chapter 12 "Care, maintenance and disposal”

Basic infos

Calculation of safety distance S

Optical protective devices can only perform their protective function if they are mounted with adequate
safety distance. When mounting, all delay times must be taken into account, e.g. the response times of the
safety sensor and the control elements as well as the stopping time of the machine.

The following standards specify calculation formulas:

» 1SO 13855 — Safety of machinery — The positioning of protective equipment in respect to approach
speeds of parts of the human body Cultivation situation and safety distances.

General formula for calculating the safety distance S of an Optoelectronic Protective Device acc. to
EN ISO 13855

S=K.-T+C
S [mm] Safety distance
K [mm/s] Approach speed
T [s] Total time of the delay, sum from (t, + t; + t,,)
t, [s] Response time of the protective device
t; [s] Response time of the safety relay
tn [s] Stopping time of the machine
C [mm] Additional distance to the safety distance
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6.1.3

If longer stopping times are determined during regular inspections, an appropriate additional
time must be added to t,.

Suitable mounting locations
Area of application Mounting
Inspector: Technician who mounts the safety sensor

Tab. 6.1: Checklist for mounting preparations

Check: Yes No

Is the safety distance to the hazard location maintained?

Has the scanning angle of the safety sensor as given on the marking/template on
the top of the sensor been taken into consideration?

Can the point of operation or the danger zone only be accessed through the pro-
tective field?

Have measures been taken to prevent the protective field from being bypassed by
crawling under?

Is stepping behind the protective device prevented or is mechanical protection
available?

Can the safety sensors be fastened in such a way that they cannot be moved and
turned?

Is the safety sensor accessible for testing and replacing?

Is it impossible to actuate the reset button from within the danger zone?

Can the entire danger zone be seen from the installation site of the reset button?

If you answer one of the items on the checklist with no, the mounting location must be changed.

Mounting the safety sensor
Proceed as follows:

v’ Calculate the necessary safety margin and determine the surcharges required for your application; see
chapter 6.1.1 "Calculation of safety distance S".

v Determine the mounting location.
% Please note the information on installation locations; see chapter 6.1.2 "Suitable mounting locations".
% Ensure that machine parts, safety guards or covers do not impair the safety sensor's field of vision.

% Make sure that the scanning range of the safety sensor is not limited. To mount the safety sensor tak-
ing the scanning range into consideration, a template must be attached to the top cover of the safety
sensor.

% Make sure that no small objects are in the safety sensor's scanning range, even if these do not trigger
an object detection and the safety-related switching outputs do not switch to the OFF state.

% Make sure that the safety sensor is mounted so that good air circulation and thus heat dissipation is en-
sured.
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all dimensions in mm

Safety sensor

Template (markings on safety sensor)

Mounting location

Reference point for distance measurement and protective field radius
Area with unobstructed view; must remain free

a B~ WON -

Fig. 6.1: Mounting taking the 275° scanning range into account

N/ L

5

all dimensions in mm
1 Scanning plane
2 Area with unobstructed view; must remain free (25 mm)
Fig. 6.2: Mounting Mounting: area with unobstructed view
% Determine whether you are going to install the safety sensor with or without the mounting system.

% For direct mounting, use all four M5 threaded holes on the bottom of the device or the two M5 threaded
holes on the rear side of the device.
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% When using the two M5 threaded holes on the back of the safety sensor, ensure a screw-in depth of 6
mm and take into account the maximum screw-in depth of 6.5 mm.
When using the four M5 threaded holes on the underside of the device, a maximum screw-in depth of
5.5 mm (1) or 9.5 mm (2) must be taken into account.
Make sure that the mounting elements or construction can carry at least four times the weight of the de-
vice with mounting system.

¢
&3

b

1 M5 threaded hole, 5.5 mm deep
2 M5 threaded hole, 9.5 mm deep

Fig. 6.3: Maximum screw-in depth

% Tighten the M5 screws with a tightening torque of 2.3 Nm on the safety sensor.

% Use a screw locking adhesive for strong vibrations to secure the fastening screws.

% Have the appropriate tools at the ready and mount the safety sensor.

% Install protective enclosures or safety bars if the safety sensor is in an exposed position.

% If there is a risk that the safety sensor will be used as a climbing aid, install a suitable physical cover
over the safety sensor.

% Align the mounted safety sensor horizontally and vertically.

% Attach safety notice stickers to the mounted safety sensor (the stickers are included in the delivery con-
tents).

% Configure the safety sensor with the configuration and diagnostics software; see chapter 8.2 "Configur-
ing the safety sensor".
Note the information on response times, machine stopping time and protective field dimensioning for
your application.
Determine the protective field size based on the mounting location, the calculated safety distances and
additional distances.

If the protective field boundaries < 190 mm, object detection can be limited due to the
measurement error.

% When defining the protective field, take the additional distance Z, to the protective field con-
tour into account (see chapter 6.2 "Stationary danger zone guarding").

% Configure the protective field so that the safety-related switching outputs switch off from every accessi-
ble point with sufficient minimum distance D.

% Determine the start-up/restart operating mode required for the application.
% If you are using start and/or restart interlock, determine the position for the reset button.

% Many safety-relevant parameters are preset for each application in the configuration and diagnostics
software. Use these preset values where possible.

% Determine the conditions for the field triple switchover and the sequence of the field triple switchover.
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% Create a verification document for the device configuration and protective field dimensioning.
The document must be signed by the person responsible for the configuration.
Attach this document to the machine documentation.

% Mark the protective field boundaries on the floor.
You can easily test the safety sensor along this marking.

After mounting, you can electrically connect (see chapter 7 "Electrical connection"), start up and align (see
chapter 9 "Starting up the device") as well as test (see chapter 10 "Testing") the safety sensor.

Information on protective field dimensioning

If the protective field boundaries < 190 mm, object detection can be limited due to the
measurement error.

% When defining the protective field, take the additional distance Z,, to the protective field con-
tour into account (see chapter 6.2 "Stationary danger zone guarding").

% Dimension the protective field big enough that the safety sensor's switching signal can stop the danger-
ous movement in good time.

% If several protective fields are selected with field pair changeover, this condition applies for all protec-
tive fields.

% If you cannot sufficiently dimension a protective field, use additional protective measures, e.g. safety
guards.

% Ensure that the protective field cannot be walked behind in the direction of the danger zone.

% Observe all delay times, e.g. safety sensor response times, control element response times, braking
times or machine or automated guided vehicle stopping times (AGV).

% Take changed delay times, which, for example, can be caused by reducing the braking force, into ac-
count.

% Observe shadowing effects, e.g. surfaces and areas behind static objects. People in the shadows of
these objects will not be detected by the safety sensor.

% Observe the lateral tolerance when dimensioning the protective fields (see chapter 14 "Technical
data").

% Do not use cone-shaped protective field contours, as these do not guarantee any protective function.
% Take the additional distances required for the application into account.

Handling unmonitored areas

There is an area behind the safety sensor that the safety sensor does not monitor. Unmonitored areas can
also materialize, e.g. if you install a safety sensor on a rounded off vehicle front.

It must not be possible to walk behind unmonitored areas.
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1 Safety sensor
2 Protective field

3 Unmonitored area;
Optimum availability at a distance of 50 mm to fixed contours

Fig. 6.4: Unmonitored area
% Prevent access to an unmonitored area with screens.
% Prevent walking behind by countersinking the safety sensor into the machine contour.

Countersinking into the machine contour, min. 95 mm
Minimum distance above the scanner unit, min. 10 mm
Protective field

Safety sensor

Machine

Angled physical cover

o B~ WON -

Fig. 6.5: Stepping behind protection by countersinking into the machine contour

% Use a physical cover set at an angle over the safety sensor if you expect that the safety sensor will be
used as a climbing aid or standing surface.
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Protective field setup with adjacent safety sensors

The safety sensor has been developed in a way that prevents several safety sensors from interfering with
one another as much as possible. Nevertheless, if several safety sensors are positioned adjacent to each
other, this may result in a reduction in the availability of the safety sensors.

% When mounting the safety sensor, avoid glossy surfaces directly behind the optics cover.

% Plan for shielding with stationary applications. The shielding must be at least as high as the safety sen-
sor's optical hood and flush with the front housing edge.
If you provide the shielding within the indentation in the machine contour, the resolution of the protec-
tive fields is not compromised at any accessible point.
You need the reciprocal shielding for both horizontal and vertical alignment of the protective fields.

1 Point of operation

2 Safety sensor

3 Machine with countersinking for sensor installation
4 Protective fields

5 Shielding

Fig. 6.6: Shielding against the influence of neighboring protective fields
% Install the safety sensors off-set on the height.

1 Minimum distance, 140 mm (for distance between neighboring scanners <9 m)
2 Scanning plane

Fig. 6.7: Height offset mounting, parallel alignment
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6.2

% Install the safety sensors with crossed alignment.

1 Scanning plane

Fig. 6.8: Mounting beside one another, without height offset, crossed alignment

1 Scanning plane

Fig. 6.9: Mutually opposing mounting, without height offset, crossed alignment

Stationary danger zone guarding
The safety sensor takes over the stop-activating and presence-detecting function.

Calculation of safety distance S for parallel approach to the protective field

S=K.-T+C
Sro [mm] Safety distance
K [mm/s] Approach speed for danger zone guarding with approach direction parallel to the protective
field (resolution up to 90 mm): 1600 mm/s
T [s] Total time of the delay, sum from (t, + t, + t.))
t, [s] Response time of the protective device
t [s] Response time of the safety relay
tn [s] Stopping time of the machine
C [mm] Surcharge for securing the danger area with approach reaction, see below

Response times, stopping time of the machine

The cycle time of the safety sensor is 25 ms, which corresponds to one scan. At least two consecutive
scans must be interrupted so that the safety-related switching outputs switch off. The safety sensor's mini-
mum response time is therefore 75 ms.

If you want to increase the safety sensor's availability in an environment with fine particles, increase the
number of interrupted scans after which the safety-related switching outputs switch off. With each addi-
tional scan the response time t, increases by 25 ms. With K = 1600 mm/s the safety distance increases by
40 mm per additional scan.

% Select a response time t, of at least 125 ms or higher.

% Determine the machine/system's stopping time t,.
If data is not available, you can commission Leuze to perform measurements (see chapter 13 "Service
and support".).

% If an increase in the stopping time within the regular test periods is to be expected, take an additional
time into account for the machine's stopping time t,,.
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Surcharge C for securing the danger area with approach reaction

You prevent reaching the point of operation by reaching over with the additional distance C:

C =1200-0,4-H

[mm]
[mm]
[mm]
[mm]
[mm]

[mm]

Additional distance for safeguarding the danger zone

= Height of protective field above floor (installation height)
850 mm

1000 mm

Minimum permissible mounting height, but never less than 0
Hin = 15 % (d - 50)

Arrangement of the protective device

The minimum permissible installation height depends on the resolution of the safety sensor:

Tab. 6.2:

50 mm

Additional distance C depending on the resolution of the safety sensor

0 mm 1200 mm

70 mm

300 mm 1080 mm

Application-related additional distances for safety distance S

The protective field boundaries must be defined so that the calculated safety distance S to the point of op-
eration, extended by the additional distances, is complied with everywhere. Where this is not possible or
does not make sense, you can use hard guards as supplementary measures.

On s wN =~

Routing machine with free space for sensor protective field in the area under the machine table
Safety sensor

Protective field contour

Warning field contour

Calculated safety distance S

Minimum distance D (= safety distance S + additional distance Zg, + Zggr, Wwhere required)

Rs  Largest protective field radius without additional distances, measured from the rotation axis of the rotary mirror

Fig. 6.10:

Leuze electronic GmbH + Co. KG

Defining the protective field contour for a stationary, horizontal protective field

RSL210 36



Mounting Leuze

% Define the limits of the protective field using the safety distance S without an additional distance.
% Determine the biggest protective field radius R for this protective field.

% The biggest protective field radius determines the additional distance Zg, for the system-related mea-
surement error, by which the protective field contour must be enlarged. The position of the rotary mir-
ror's center point with regard to the housing is provided by the dimensioned drawings.

Tab. 6.3: Additional distance Zg,, for the protective field contour because of measurement error
Biggest protective field radius R; without additional distances Additional distance Zg,
<3,00m 100 mm

% Avoid retro-reflectors at the beam level beyond the protective field boundaries. If this is not possible,
add another additional distance Zggr of 100 mm.

Minimum distance D to the protective field contour
The minimum distance D is the distance between point of operation and protective field contour.

D = S+Zgy+ZrerL

D [mm] = Minimum distance between the point of operation and the protective field contour
S [mm] Safety distance

Zsy [mm] = Additional distance for system-related measurement error

Zeerl [mm] = Additional distance for retro-reflectors

% If the protective field runs up against fixed boundaries, such as walls or machine frames, take a coun-
tersinking into the machine contour of at least the size of the necessary additional distance Z,,, and
Zrer. Where required, into account. With the protective field contour under these conditions, stay about
50 mm away from the machine surface.

% If the protective field runs up against hard guards, ensure that the protective field ends under instead of
in front of the hard guards. The width of the lower post must correspond with the size of the required
additional distances.

% If all hazards in the fenced off area are covered by the safety sensor and the height of the beam level is
300 mm, you can raise the bottom edge of the hard guards from 200 mm to 350 mm in the protective
field range. The protective field reaching to under the hard guards takes over the protective function of
preventing an adult from crawling under in this case.

% Prevent obstructions within the calculated protective field boundaries. If this is not possible, implement
protective measures so that the point of operation cannot be reached from out of the shadow of the ob-
struction.

6.3 Mobile danger zone guarding on AGVs

Danger zone guarding protects people and objects that are in rooms in which vehicles move in, e.g. auto-
mated guided vehicle systems (AGVs).

A horizontally arranged protective field protects people and objects that are in the vehicle's path and are
detected by the front edge of the protective field.

% The operator of the machine must use organizing measures to prevent people from entering
the protective field of the vehicle from the sides or being able to move towards an approach-
ing vehicle.

% Only use the safety sensor on vehicles with electrical drive and electrically influenced drive and braking
devices.

% Only install the safety sensor on the front of the vehicle.
If you must also guard the reverse travel, you must also install a safety sensor on the rear of the vehi-
cle.

% Mount the safety sensor on the vehicle so that there are no unmonitored areas = 70 mm between the
protective field and vehicle front.
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% Set the mounting height such that the beam level is not more than 150 mm above the floor. A person
lying on the floor can therefore be safely detected.

% The scanning level is located in the upper area of the optics hood (see chapter 3.2 "Device overview"

Danger of invalidation of the protective device!
To be able to reliably detect a person lying on the floor, the scanning level must be mounted at a

maximum height of 150 mm.

In most cases, a mounting height (height of the scanning level above the floor) of at least 60 mm (consider
sufficient ground clearance depending on the installation situation of the safety sensor) when only using the
safety function and at least 120 mm when also using the safety sensor for navigation support is suitable,
depending on the floor conditions. When determining the mounting height, it must also be ensured that the
safety sensor does not come into contact with the floor as a result of vertical movements of the vehicle, for

example when driving over a speed bump, as this can cause damage to the device and render the protec-
tive device ineffective.

‘ >80 mm* > 60 mm*
(max. 170 mm) (max. 150 mm)

o 260 mm
f (max. 150 mm)

(max. 130 mm)

* Ensure sufficient ground clearance

Fig. 6.11: Recommended mounting height for RSL 210, RSL 220 and RSL 230 on AGVs (use of the safety func-
tion)
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6.3.1

Minimum distance D

D = Da+Zges
D [mm] Minimum distance, vehicle front (danger) to protective field front edge
D, [mm] Stopping distance
Ziot [mm] = Sum of required additional distances

200
| D
A
ZGES
D
Fig. 6.12: Mobile danger zone guarding, calculation of required minimum distance D
Stopping distance D,
Dp = Viax (Ty+Ty)+Dg- Ly Ly
D, [mm] Stopping distance
Vinax [mm/s] Maximum vehicle speed
T, [s] Safety sensor response time
T, [s] = Response time of the AGV
Dg [mm] = Braking distance with v,,,, and maximum vehicle load
L, [--] = Factor for brake wear
L, [--] = -Factor for problematic floor conditions, e.g. dirt, wet conditions
Additional distances Z
Zges = Zsm+ Zr + ZRerL
Ziot [mm] = Total of the required additional distances
Zsu [mm] Surcharge for system-related measurement error, see chapter 6.2 "Stationary danger zone
guarding”
Z [mm] = Additional distance required with lack of floor space H¢
ZrerL [mm] = Additional distance required with retro-reflectors beyond the protective field boundaries;

Zger, = 100 mm

The additional distance Z, is always required. Its size depends on the biggest radius R; from the safety
sensor mirror's rotary axis to the protective field boundary without Z.. The position of the rotary mirror axis
depends on the installation situation.

If the distance between the vehicle and the ground (ground clearance H;) is less than 120 mm, there is a
risk of parts of the foot becoming trapped underneath the vehicle before the vehicle comes to a standstill
when the person above the foot is detected. An additional distance Z; to the protective field, which is de-
termined according to the following diagram, is required:
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6.3.2

120
100 I~

80 BN
60

40
20

ZF

20 40 60 80 100120140160

Fig. 6.13: Diagram for determining the additional distance Z: with lack of floor space H:
With a vehicle height of less than 50 mm, an additional distance Z; of 150 mm is always required.
If wheels are mounted near the side wall, always add an additional distance Z- > 150 mm.

Protective field dimensions

[%]
w
o
N
D, ZGEs__

D
D Minimum distance, vehicle front (danger) to protective field front edge
D4 Stopping distance
Zior Total required additional distances to the front and for both sides
Fo Distance from safety sensor center to left vehicle edge
Fr Distance from safety sensor center to right vehicle edge
Rg Biggest radius in the protective field without Z;4; for determining the additional distance Zg,
Fig. 6.14: Mobile danger zone guarding, dimensions for horizontal protective field

% Select 70 mm resolution.

% Set the protective field length so that the response time until braking and the braking distance, including
factors for wear and tear and floor conditions, and any necessary additional distances are taken into
account.

% Arrange the protective field symmetrically with reference to the vehicle width, even if the safety sensor
is not arranged centered.

% Configure an upstream warning field that reduces the vehicle's speed. A full brake with a subsequent
interruption of the protective field is then executed moderately and is less demanding on the vehicle's
drives.

% Dimension the minimum distance D for the maximum speed as if the speed reduction initiated by the
warning field had not happened.
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% Take the required free space for lateral protrude protective fields under the roller conveyors along the
transportation path into account.

% If you have to expect angular deviations of the vehicle during the travel, plan an additional tolerance
area to guarantee undisturbed travel operation.

6.4 Mounting accessories

6.4.1 Mounting system

Using the mounting system you can adjust the safety sensor horizontally and vertically by +5 degrees when
mounting.

Fig. 6.15: Mounting with wall bracket
% Mount the wall bracket on the system side. Two cylinder head screws M5x16 with washers are included
for this purpose.
% Mount the safety sensor with the included countersunk head screws M5x10 on the BT 500M mounting
adapter (tightening torque = 2.3 Nm).
% Mount the safety sensor (with the fastening adapter) on the BTU 500M assembly system. In doing so,
tighten the countersunk screw to 4.5 Nm.

% Align the safety sensor vertically and horizontally on the BTU 500M mounting system:
— using the slotted holes in the wall section with the M5 cylinder head screws and
— the inclination using the slotted holes of the M4 cylinder head screws.

% After alignment, fix the safety sensor by tightening the four cylinder head screws M4 with 3.0 Nm and
the on-site cylinder head screws M5.

ing adapter. In this case, it must be taken into account that the scanning range is limited to
-135°... +135°.

ﬂ The scanner can also be mounted directly on the mounting system without the BT 500M mount-
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6.4.2 Loop guard

The loop guard for the optics cover prevents damage to the safety sensor caused by light contact with for-
eign objects.

The BTP 500M protective bracket can be used individually for direct mounting or in combination with the
BTU 500M mounting system if vertical or horizontal adjustment of the safety sensor is necessary.

Q)

Fig. 6.16: Mounting with wall bracket and protective bracket

The protective bracket is mounted with the mounting system as described above, see chapter 6.4.1
"Mounting system". Only the BT 500M fastening adapter is replaced by the BTP 500M protective bracket.
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7

71

Electrical connection

Faulty electrical connection or improper function selection may result in serious injury!
% Only allow competent persons to perform the electrical connection.

% For access guarding, activate the start/restart interlock and make certain that it cannot be
unlocked from within the danger zone.

% Select the functions so that the safety sensor can be used as intended (see chapter 2.1 "In-
tended use").

% Select the safety-relevant functions for the safety sensor (see chapter 4.2 "Function modes
of safety sensor").

% Always loop both safety-related switching outputs OSSD1 and OSSD?2 into the work circuit
of the machine.

% Signal outputs must not be used for switching safety-relevant signals.

Laying of cables

% Lay all connection cables and signal lines within the electrical installation space or permanently in cable
ducts.

% Lay the cables and lines so that they are protected against external damages.
For further information: see EN ISO 13849-2, Table D.4.

Observe the maximum cable length!
Observe the maximum cable lengths as a function of operating voltage and load current.

Observe when wiring with terminals and connectors

In the case of wiring that continues beyond the device or during repairs to connectors, the user must en-
sure that cables or conductors that have defectively disconnected cannot result in contact with other sig-
nals.

% Use suitable terminals.
% Use heat-shrink tubing, wire-end sleeves or similar.

NOTICE

Protective Extra Low Voltage (PELV)!

0 The device is designed in accordance with protection class Il for supply with PELV (Protective
Extra-Low Voltage).

% Acc. to IEC/EN 60204-1, the external power supply must demonstrate the ability to bridge
short-term mains failures of up to 20 ms. The power supply unit must ensure safe mains
separation (SELV/PELV) and a current reserve of at least 2 A.

Electrical supply
see chapter 14.1 "General specifications”

Functional earth

NOTICE

0 Always connect the housing of the safety sensor to functional earth or ground!

% The housing of the safety sensor must always be connected to earth (functional earth) or
machine/vehicle ground.

% If the safety sensor is attached to a non-conductive material (e.g. a concrete wall), the hous-
ing of the safety sensor must be earthed.
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» Factory recommendation: Functional grounding via ground strap/wire (low-resistance for HF). The cor-
responding screw-on points on the underside of the device are provided for grounding.

» Functional grounding via the shield of the connection cable.
For grounding, the shield of the connection cable in the switch cabinet must be connected to earth or
machine/vehicle ground.

% If the housing of the safety sensor or the mounting bracket — despite being mounted on a non-conduc-
tive material — is connected to metallic parts (even temporarily), you must ensure that the appropriate
potential equalization is provided between the switch cabinet and housing potential; e.g. by grounding
the Ethernet connection.

7.2 Cable lengths depending on the supply voltage
The maximum cable length is determined by voltage drops on the supply and signal lines.
The following conditions apply to the necessary supply voltage Ug at the safety sensor's input terminals:
» Uz must be greater than the permissible nominal voltage limit of 16.8 V.

NOTICE

The recommended supply voltage is at least 16.8 V!
Leuze recommends a supply voltage Ug of at least 16.8 V at the input terminals of the safety
Sensor.

% The operating voltage should not be allowed to drop below the recommended value if possi-
ble.

* The necessary operating voltage Uz must also ensure the function of the downstream devices in the
case of a linear configuration.

» Once the operating voltage Uy has been determined, check whether the resulting signal voltages
are sufficient for the downstream devices.

» Take into account the voltage drops in the safety sensor — up to 1.8 V — and on the signal wiring.

@

24
23
22
21
20
19
18

17

16

15 @
5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85

Supply voltage [V]

Cable length [m]

RSL 210/220 None of the universal I/Os is configured as an output.

RSL 210/220 One of the universal I/Os is configured as an output.

RSL 210/220 All four general-purpose 1/Os are configured as outputs.

a b~ ON =

Fig. 7.1: Diagram for estimating the voltage drop on the supply line (line cross-section = 0.25 mm? (8-pole line))
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7.3 Interfaces
The safety sensor has the following interfaces, depending on the version:
* Interface for connection with the control system
» Ethernet interface for communication with PC or laptop
» USB interface for communication with PC or laptop
+ Bluetooth interface for communication with PC, notebook or mobile device

Tab. 7.1: RSL 210 and RSL 220 interfaces

Interface Type Function
Control M12 connector, 8-pin, A- » Power supply
coded

« Switching and signal lines

Communication USB 2.0 type C socket Configuration and diagnostic interface:

« Parameter configuration

 Protective field definition and warning field defi-
nition

 Display of the measurement contour

« Diagnosis

Communication Bluetooth Configuration and diagnostic interface:

» Parameter configuration

 Protective field definition and warning field defi-
nition

» Display of the measurement contour

» Diagnosis

A protective cap on the M12 socket protects the communication interface when no Ethernet cable is con-
nected.

7.3.1 Bluetooth interface

The safety sensor has an integrated Bluetooth interface that is intended for temporary use to transfer diag-
nostic data to a PC or mobile device.

The Bluetooth interface can be activated/deactivated using the configuration and diagnostic software Sen-
sor Studio and is activated when the device is delivered (see chapter 8.2.2 "Connecting safety sensor to
PC").
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NOTICE

0 This equipment has been tested and found to comply with the limits for a Class B digital device,

pursuant to part 15 of the FCC Rules (Contains FCC ID: ABTBM78ABCDEFGH). These limits
are designed to provide reasonable protection against harmful interference in a residential in-
stallation. This equipment generates, uses and can radiate radio frequency energy, and if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

- Consult the Leuze Service Hotline or an experienced radio technician for help.

This device complies with Industry Canada's license- exempt RSS standard(s). Operation is
subject to the following two conditions:

(1) This device may not cause interference; and

(2) This device must accept any interference, including interference that may cause undesired
operation of the device.

This device complies with Industry Canada's RSS for license-exempt radio equipment. Opera-
tion is authorized subject to the following two conditions:

(1) this device may not cause interference to radio communications;

(2) the user of this equipment must accept any interference received, even if such interference
is likely to cause undesired operation.

Guidelines on Transmitter Antenna for License Exempt Radio Apparatus:

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of
a type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To re-
duce potential radio interference to other users, the antenna type and its gain should be so cho-
sen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication.

In accordance with Industry Canada regulations, this radio transmitter may be operated with an
antenna of the type and maximum gain (or less) approved for the transmitter by Industry
Canada. To reduce the risk of radio interference to other users, the antenna type and gain must
be chosen so that the equivalent isotropically radiated power (e.i.r.p.) does not exceed the inten-
sity required to establish satisfactory communication.
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7.3.2 Pin assignment for control
The safety sensor is equipped with an M12 connector.
Fig. 7.2: Pin assignment for M12 connector, 8-pin, A-coded
Tab. 7.2: Pin assignment
Pin Signal Function
1 A4 /| RES  Start/restart input
» Acknowledgment
+ Alternatively: State signaling (configurable)
+24 VDC Supply voltage
A2 Contactor monitoring
State signaling (configurable)
4 A3 Contactor monitoring
State signaling (configurable)
5 OSSD 1 Safety-related switching output
6 OSSD 2 Safety-related switching output
7 0VvDC Ground of the supply voltage
8 A1 State signaling (configurable)
Thread FE Functional earth/shield
7.4 Circuit diagram example
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8 Configuration

8.1 Configuration and diagnostics software - Sensor Studio

To start up a safety sensor in your application, the safety sensor must be set up according to its specific
use using the configuration and diagnostic software. The software is used to set up the safety configuration
of the safety sensor, to change the communication and diagnostics settings and to perform diagnostic rou-
tines. Communication takes place via the PC.

The software is designed according to the FDT/DTM concept:
* You make the individual configurations for the safety sensor in the Device Type Manager (DTM).

» The individual DTM configurations of a project can be called up via the frame application of the Field
Device Tool (FDT).

» Each device DTM has a communication DTM that sets up and monitors the communication connec-
tions to the sensor.

8.1.1 System requirements
To use the software, you need a PC or laptop with the following specifications:

Hard disk space At least 400 MB free memory
If you want to save the protective field or configuration values, you will
need more memory.

Input device Keyboard and mouse or touchpad
Output device Printer (black-white or color)
Interfaces RJ45 Ethernet network

Bluetooth (optional) - If the PC does not have integrated Bluetooth technol-
ogy, use an appropriate USB or PCMCIA adapter if necessary.

Operating system Microsoft® Windows 11 or higher

Only the term "PC" is used below.

8.1.2 Installing software
Prerequisites:
* You do not need the safety sensor to install the software on the PC.
* All Windows applications are closed.
The software is installed in two steps:
* Installing the Sensor Studio FDT frame.
» Device Manager (DTM) Installing a security device package

Installing the Sensor Studio software
% Call up the Leuze website: www.leuze.com.
% Enter the type designation or part number of the device as the search term.
% The configuration software can be found on the product page for the device under the Downloads tab.
% Download the configuration and diagnostic software.
% Double-click the SensorStudioSetup.exe file.
% Select a language for the interface text in the installation wizard and software and confirm with [OK].
= The installation wizard starts.
% Click [Next].
= The installation wizard opens the software license agreement.
% If you want to accept the license agreement, select the appropriate option field and click [Next].

% If the suggested installation path is OK, click [Next].
If you want to specify a different path, click the [Browse] button. Select a different path, confirm with
[OK] and click [Next].
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% Click the [Install] button to start installation.
= The wizard installs the software and places a shortcut on the desktop (insert symbol).
% Click the [Finish] button to complete installation.

Device Manager (DTM) Installing a security device package

Prerequisites:
» The Sensor Studio software is installed on the PC.
% Double-click the file LeSafetyCollectionSetup.exe.

% Select a language for the interface text in the installation wizard and software and confirm with [OK].

= The installation wizard starts.
% Click [Next].
= The installation wizard opens the software license agreement.

% If you want to accept the license agreement, select the appropriate option field and click [Next].

% If the suggested installation path is OK, click [Next].
If you want to specify a different path, click the [Browse] button. Select a different path, confirm with
[OK] and click [Next].

% Click the [Install] button to start installation.
= The wizard installs the software.
% Click the [Finish] button to complete installation.

NOTICE

i

During installation of the software, a user admin (without password query) is created so that you
can start the software without user identification. If other users are registered (Tools > User
management in the FDT frame menu), you must log in at the software with a user name and
password.

This setting allows you to connect to the safety sensor and to read out, upload, enter or change
the safety configuration and all settings using the RSL 200 device DTM. The password for the
safety sensor only needs to be entered (i.e. the access level only needs to be changed) when
the changes are downloaded to the safety sensor (see chapter 8.1.6 "Selecting access level").
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8.1.3 User interface
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Fig. 8.1: User interface of the software

FDT frame menu
The device managers (DTM) of the safety sensors are created and managed in the FDT frame menu.

Device manager DTM

Configuration projects for setting up the selected safety sensor are created and managed in the device
managers (DTM) of the safety sensors.
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Fig. 8.2: User interface with project tree view

The project tree view shows the structure of the currently installed device managers (DTM). In the project
tree view you can, for example, add copies of an already configured device manager (DTM) quickly and
easily to the DTM structure if you want to operate multiple safety sensors with the same configuration set-
tings.

Example: Example: AGV with safety sensors on front and rear side

8.1.4 FDT frame menu

You can find complete information on the FDT frame menu in the online help system. Select the
Help menu item in the menu [?].

Project wizard
Using the Project Wizard you can create and change configuration projects for setting up the safety sensor

(see chapter 8.1.5 "Using configuration projects").

% Start the Project Wizard in the FDT frame menu by clicking the & | button.

Information on the Project Wizard can be found in the online help for the FDT frame menu under
Sensor Studio Options.
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DTM change

The DTM Change function makes it easier for you to call up the communication DTM of a device or change
from device DTM to communication DTM.

& Start the DTM change function in the FDT frame menu by clicking the =1, button.

Information on DTM change can be found in the online help for the FDT frame menu under Sen-
sor Studio Options.

User management

Using the user management in the FDT frame menu, you can create users, log users in/out and manage
passwords.

Creating users

When creating a user in the user management via Tools > User management in the software frame
menu, select the access level for the user. For information on access rights and authorization levels (see
chapter 4.1 "Authorization concept of safety sensor").

% In the FDT frame menu, click on Tools > User Administration > Create User.

Logging users in/out
To be able to register and deregister users, the corresponding user must have been created beforehand.
In the FDT frame menu, click Tools > Log in/log out.

Managing passwords
To be able to register and deregister users, the corresponding user must have been created beforehand.
% In the FDT frame menu, click on PROJECT > Options > User accounts / Passwords.

NOTICE

Password management via the FDT frame menu applies to all installed device managers (DTM)
of the project.

Whenever write access occurs, the safety sensors of the RSL 200 series always check the ac-
cess level (Engineer, Expert) and the password defined via the device manager (DTM) (SET-
TINGS > Passwords) independently of the password management via the FDT frame menu.

Exiting Sensor Studio

When you have finished making the configuration settings, close the configuration and diagnostics soft-
ware.

% Exit the program via File > Exit.
% Save the configuration settings as a configuration project on the PC.
You can open the configuration project again at later time via File > Open or with the Sensor Studio Project

Wizard (& ).

Using configuration projects

Configuration projects are created and managed in the device manager (DTM) of the selected safety sen-
SOfr.

NOTICE

During installation of the software, a user admin (without password query) is created so that you

can start the software without user identification. If other users are registered (Tools > User

management in the FDT frame menu), you must log in at the software with a user name and
password.

This setting allows you to connect to the sensor and to read out, upload, enter or change the
safety configuration and all settings using the RSL 200 device DTM. The password for the sen-
sor only needs to be entered (i.e. the access level only needs to be changed) when the changes
are downloaded to the safety sensor (see chapter 8.1.6 "Selecting access level").
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% Start the configuration and diagnostics software on the PC by double-clicking the ﬂ button.
= The mode selection of the Project Wizard is displayed.

= If the mode selection is not shown, start the project wizard in the FDT frame menu by clicking the
[Project Wizard] button.

44 Sensor Studio - O d

Sensor Studio 2
B W & Leuze electronic
“ Mode selection the sensor people

Define the subsequent procedure.

() Device selection with device search and establishment of connection (onling)

{® Device selection without communication connection (offline)

() Opening a stored project file
C\Users‘trufDesktop Test Projekt fdx

Mext = Cancel

Fig. 8.31: Start project assistant
% Select the configuration mode and click [Next].
» Automatic connection to a connected safety sensor (Online)
» Device selection without communication connection (offline)
* Load a saved project again

When selecting the configuration mode Online:

The project wizard displays the SEARCH DEVICES dialog box.
% Select the interface and click the [Start] button.

% Select the safety sensor for your configuration project that you want to connect to and click the [Next]
button.

= The project wizard displays the device list of configurable safety sensors in the SEARCH DEVICES di-
alog box.
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Fig. 8.3: Device selection in project wizard

When selecting the configuration mode Offline:

% To establish a connection with the safety sensor after selecting offline operation, search for the safety
sensor for your configuration project using the search function of the communication DTM.
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Fig. 8.4: Communication DTM with search function
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The project wizard displays the device list of configurable safety sensors in the SEARCH DEVICES dialog
box.

% Select the safety sensor from the device selection list and click [Next].

= The device manager (DTM) of the safety sensor shows the initial screen for the configuration project.
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Fig. 8.34: Start screen for the configuration project

The device manager (DTM) starts without querying the access level of the user. During commu-
nication with the safety sensor, the safety sensor does however query the access level of the
user. To change the authorization levels (see chapter 8.1.6 "Selecting access level").

Use device manager

Using the menus of the device manager (DTM) you can set the parameters of the safety configuration. The

online help system provides information on the menu items and adjustment parameters. Select the Help
menu item in the menu [?].

8.1.6 Selecting access level

With the device manager, you can change the authorization level of the user if necessary.
For the authorization concept of the software, see chapter 4.1 "Authorization concept of safety sensor".

% Click in the DTM menu bar on the [Change access level] button (H).
= The Change access level dialog box opens.

% In the Access level list, select the item Expert, Engineer or Observer and enter the default password or
the password defined for the individual user.

The following access levels are available:
» Observer can read everything (no password)
» Expert can change communication and diagnostics settings (default password = comdiag)
» Engineer can additionally change the safety configuration (default password = safety)

The password is case-sensitive (i.e. a distinction is made between upper-case and lower-case letters).
% Confirm with [OK].
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8.1.7

8.1.10

IDENTIFICATION

Detailed information on the menu items and setting parameters can be found in the information area and in
the online help. Select the Help menu item in the menu [?].

* RSL 200 safety laser scanner
« Sensor and configuration data

PROCESS

Detailed information on the menu items and setting parameters can be found in the information area and in
the online help. Select the Help menu item in the menu [?].

» Sensor display Device display in the DTM menu
» Sensor display
+ State of the active protective and warning fields
* Measurement contour
» Optics cover status (yellow):
 Inputs / outputs
« Sensor display
» Connections and signals
* UDP measurement data
+ Settings and information
» Distance
+ Signal strength

CONFIGURATION
see chapter 8.2 "Configuring the safety sensor”

You can only transfer changes made in the CONFIGURATION menu to the safety sensor if you
are logged in with the access level Engineer.

DIAGNOSIS

Visually identify device

If you have installed multiple safety sensors, identify the safety sensor that is connected to the currently
open device manager (DTM).

Prerequisites: The software and safety sensor are connected.
% In the DIAGNOSIS menu, click the [Visually identify sensor].
= On the display of the safety sensor connected to the device manager (DTM), LEDs 4 and 5 flash green
for 30 seconds.
Resetting the sensor (only possible with authorization level Engineer)
% Acknowledge messages and faults
% Set safety sensor to safety mode

Create and save service file
The service file contains all available information on the safety sensor as well as configuration and settings.

% When requesting support, send the service file to the Leuze customer service (see chapter 13 "Service
and support").
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8.1.11

Diagnostics list
Access list

EventLog signals

SETTINGS

logged in with the access level Engineer.

0 You can only transfer changes made in the SETTINGS menu to the safety sensor if you are

Communication

* LAN
+ DHCP
+ CONNECTION SETTINGS
* MAC address

+ USB
* DHCP
+ CONNECTION SETTINGS
» Sensor data

* Bluetooth
+ Activate Bluetooth module
» Activate device scan
* Bluetooth address

EventLog

Trigger signals output when certain events occur, are recorded and shown in the event list of the safety
sensor.

The state of the monitored signals is displayed in the configuration and diagnostics software Sensor Studio
in a detailed table view, in a signal flow diagram and in a graphical display (protective field violations).

Information on the monitored signals can be found in the Sensor Studio configuration software in the infor-
mation area and in the online help. Select the Help menu item in the menu [7?].

Passwords

If a user has forgotten his password for login at the safety sensor or has repeatedly entered the
password incorrectly, he cannot log in at the safety sensor. The CHANGE PASSWORD function
is therefore not available.

To reset the password, a user must generate a reset password and have it confirmed by the
manufacturer.

Change password
% Define individual passwords for the access levels Engineer and Expert. These passwords replace the
default passwords set by the manufacturer.
The password is case-sensitive (i.e. a distinction is made between upper-case and lower-case letters).
Reset password
Prerequisites:
* The software is connected to the safety sensor.
% Generate a one-time password. Note down the generated reset password.
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% Send the reset password to the Leuze customer service for confirmation(see chapter 13 "Service and
support").
The device can now be switched off and the connection can be terminated.

% Enter the confirmed reset password and create a new password.

Optics cover
» Monitoring of optics cover
 Dialog box for calibrating a replacement optics cover

8.2 Configuring the safety sensor
To start up the safety sensor in your application, the safety sensor must be individually adapted using the
software. All configuration data is defined using the configuration and diagnostics software.
General procedure for configuring safety sensor
% Assessing the risk
* The system has been determined and its boundaries defined.
» The safety sensor has been selected as the safety component.

» The type of guarding has been determined (danger zone guarding, point of operation guarding, access
guarding).

% Calculating safety distance
Shape and size of the protective and warning fields

% Configuring the safety sensor

» Configuration and diagnostics software (see chapter 8.1 "Configuration and diagnostics software - Sen-
sor Studio")

» Determine configuration project (see chapter 8.2.3 "Determine the configuration project")
» Configure protective function (see chapter 8.2.4 "Configuring protective function")
% Check function (see chapter 10 "Testing")

8.2.1 Defining safety configuration

ﬁ Serious accidents caused by incorrect safety configuration!

The protective function of the safety sensor is only ensured if the safety sensor is correctly con-
figured for the intended application.

% Allow only competent persons to perform safety configuration.

% Select the safety configuration so that the safety sensor can be used as intended (see chap-
ter 2.1 "Intended use").

% Select the protective field dimensions and contours according to the safety distance calcu-
lated for the application (see chapter 6.1.1 "Calculation of safety distance S").

% Select the parameters of the safety configuration according to your risk analysis.

& After start-up, check the function of the safety sensor (see chapter 10.1 "Before the initial
start-up and following modifications").

If the monitoring time is increased to above 5 s or if manipulation protection is deactivated, the

/Kf Additional protection against manipulation when the monitoring time is increased!
system operator must introduce other measures to prevent manipulation.

% For example, make sure that the distance range in which manipulation is possible cannot be
accessed by personnel under normal operating conditions.
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NOTICE

An error in the display (protective field contour does not match expectations or contour points
jump back and forth) or a changing display of parameter values, for example, indicate that the
configuration has been incorrectly transferred to the device. A configuration of this kind must not
be used.

&

NOTICE

OSSDs will switch off if no reflection signals are being measured!

If the safety sensor is unable to measure any reflection signals in a continuous scanning angle
of = 90° for a long period of time, the safety-related switching outputs switch off. In certain appli-
cation types (e.g. in buildings with extremely large distances), the safety sensor may not be able
to measure any reflection signals. For such application types, it is possible to set or deactivate
the monitoring times.

% In the CONFIGURATION menu, click the Device function option.
= The DEVICE FUNCTION dialog box opens.

% In the PROTECTION AGAINST MANIPULATION dialog box, define the monitoring time ac-
cording to your specific conditions.

= If the parking position is active, there will be no manipulation monitoring.

Prerequisites:

» The safety sensor is correctly mounted (see chapter 6 "Mounting") and connected (see chapter 7 "Elec-
trical connection").

» Dangerous process is switched off, outputs of the safety sensor are disconnected, and the system is
protected against being switched back on

» The size of the protective field is determined on the basis of the mounting location, the calculated
safety distances and additional distances.

» The start/restart operating mode required by the application has been determined.
* The conditions for field pair changeover, if required, have been determined.

» Configuration and diagnostics software for the safety sensor is installed on the PC (see chapter 8.1.2
"Installing software").

Many safety-relevant parameters are preset for each application in the configuration and diag-
nostics software. Use these preset values where possible.

Procedure

All configuration data is defined using the configuration and diagnostics software.
To configure the safety sensor, proceed as follows:

% Connect the PC to the safety sensor

% Start the software

» Set up communication

» Determine the configuration project

% Configure the protective function using the project wizard

 Protective/warning field configuration

» Resolution and response time
» Start-up behavior

» Contactor monitoring

 Field triple changeover

» Configuration of the signal outputs

% Save configuration project

% Transferring a configuration to the safety sensor
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% Create a record document for the device configuration and protective field dimensioning. The document
must be signed by the person responsible for the configuration.
To document the configuration, you can create a PDF file of the safety configuration or save the config-
uration and settings in an *.xml file.

The configuration data are stored in the configuration memory of the safety sensor and are
therefore also available after replacement or repair of the safety laser scanner. The configura-
tion data only needs to be transferred again if changes are made to the configuration.

8.2.2 Connecting safety sensor to PC

Connection via Bluetooth

No process data is transferred in the case of connection via Bluetooth.

Prerequisites: Bluetooth communication of the safety sensor activated (see chapter 8.2.2 "Connecting
safety sensor to PC")

% Activate the Bluetooth interface on the PC.

% Select the safety sensor as the device for the Bluetooth connection.

Distance between safety sensor and PC

The possible distance between safety sensor and PC depends on the quality of the Bluetooth
adapter that is used.
USB Bluetooth adapters with external rod antenna enable a larger operating range.

Connection via USB interface

NOTICE

Distance between safety sensor and PC with USB connection!
The USB interface of the safety sensor is connected to the USB interface on the PC with a stan-
dard USB cable (plug combination - Mini-B type / Type A).

The distance between safety sensor and PC is limited to 5 m if a standard USB cable is used.
Use active USB cables if longer cable lengths are required.

% Connect the USB cable to the safety sensor and the PC.

% Select the LAN / USB (RNDIS) interface for the device search.
% Start the device search by clicking the [Start] button.

% Select the safety sensor from the list of found devices.

cap is felt to engage when sealing. The IP degree of protection specified in the technical

% After use, seal the USB connection using a protection cap. Make sure that the protection
data is only achieved when the protection cap is closed.

Communication between safety sensor and PC
The following communication settings are active when the safety sensor is delivered:
* LAN
« DHCP DHCP: Obtain IP address automatically
+ USB
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e Bluetooth
¢ Bluetooth module activated
* Device scan activated

You can change the communication settings on the PC using the configuration and diagnostics software in
order to, for example, assign a permanent IP address to the safety sensor in your network.

% Start the configuration and diagnostics software on your PC.
= The mode selection of the Project Wizard is displayed.

If the mode selection is not displayed, start the project wizard in the FDT frame menu by clicking the button
Project > New > Project Wizard (see chapter 8.1.5 "Using configuration projects").

% Select the configuration mode Online and click [Next].
= The Project Wizard displays the device selection list containing the configurable safety sensors.
% Select the safety sensor from the device selection list and click [Next].

= The initial screen for the configuration project is displayed together with information for identification
of the selected safety sensor.

% On the home screen, click the SETTINGS tab.
= The SETTINGS menu opens.

Activating/deactivating the Bluetooth interface
% Select the menu command Communication > Bluetooth.

% Activate/deactivate communication with the safety sensor via the Bluetooth interface using the Activate
Bluetooth module checkbox. If the Bluetooth module is deactivated, communication with the safety sen-
sor via the Bluetooth interface is not possible.

% Activate/deactivate the Bluetooth device scan using the Activate device scan checkbox. If the device
scan is deactivated, the safety sensor will not be found during the Bluetooth device scan. To allow com-
munication via the Bluetooth interface, you must enter the device identification of the safety sensor
manually.

8.2.3 Determine the configuration project
% Start the configuration and diagnostics software on your PC.
= The mode selection of the Project Wizard is displayed.

= If the mode selection is not displayed, start the project wizard in the FDT frame menu by clicking the
button Project > New > Project Wizard (see chapter 8.1.5 "Using configuration projects").

NOTICE

During installation of the software, a user admin (without password query) is created so that you

can start the software without user identification. If other users are registered (Tools > User

management in the FDT frame menu), you must log in at the software with a user name and
password.

This setting allows you to connect to the safety sensor and to read out, upload, enter or change
the safety configuration and all settings using the RSL 200 device DTM. The password for the
safety sensor only needs to be entered (i.e. the access level only needs to be changed) when
the changes are downloaded to the safety sensor (see chapter 8.1.6 "Selecting access level").

% Select the configuration mode and click [Next].

= The Project Wizard shows the list of configurable safety sensors.

You can use a prepared configuration project as a template and make changes to it. To do so,
select the configuration mode Open a stored project file.

If you want to load the configuration project currently stored in the safety sensor to the PC, se-
lect the configuration mode Device selection with device scan and establishment of connection
(online).
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% Select the safety sensor in the Sensor list and click OK.

Alternatively, you can select the safety sensor by entering the part number or by specifying the sensor
range and the sensor type.

= The device manager (DTM) of the safety sensor shows the initial screen for the configuration project.
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Fig. 8.5: Safety configuration using Configuration Wizard

The device manager (DTM) starts without querying the access level of the user. During commu-
nication with the safety sensor, the safety sensor does however query the access level of the
user. To change the authorization levels, choose see chapter 8.2.8 "Selecting access level".

8.2.4 Configuring protective function

Prerequisites: Prerequisites: The safety distance, additional distances and protective field dimensions and
contours have been determined according to the mounting position (see chapter 6.1.1 "Calculation of
safety distance S").

% In the initial screen, click the CONFIGURATION tab.
= The CONFIGURATION menu opens with the options:
* Administration

 Device function

Field configurations
« Signal parameters

Creating simple safety configuration

To create a safety configuration for simple commissioning, you must first perform five configuration steps to
access the editor used for defining the contours of the protective and warning fields.

By clicking [Next], you can proceed to the next configuration step without selecting the corresponding op-
tion in the CONFIGURATION menu.

If you make changes to the default settings in a configuration step, first click the [Confirm] button and then
[Next].
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Entering administration parameters
% In the CONFIGURATION menu, click the Administration option.
= The ADMINISTRATION dialog box opens.
% In the input fields, enter the device data and the project data for the configuration project.

Configuring protective function
% In the CONFIGURATION menu, click the Device function option.
= The DEVICE FUNCTION dialog box opens.

% Determine the device functions such as resolution, maximum vehicle speed (for AGV applications), re-
sponse time, start-up behavior, external device monitoring and manipulation protection of the safety
sensor.

NOTICE

For resolution, response time and AGV speed, select the values that you used for calculating
the safety distances and additional distances for the application assigned to the configuration
bank.

NOTICE

Configuration of the start-up behavior is only implemented if the corresponding electrical signal
connections exist; see chapter 7 "Electrical connection".

NOTICE
ﬁ When the safety sensor is configured, the set restart time should correspond to at least the se-

lected response time.

Field configurations
% Select the field triple activation mode.
» Fixed selection of a field triple
+ Selection by signal inputs with fixed switchover time
% Select the changeover time.

Create protective and warning fields
A field triple consists of one protective field and two warning fields.
% In menu CONFIGURATION, right-click on option Field Configurations.
% Select Add Field Triple.
= The Add Field Triple dialog opens.

% Select the number of the field triple from the Field Triple list and click on the [Add] button. When you
have added all field triples, click on [Close].

% The added field triples are displayed in the CONFIGURATION menu as an option under Field configu-
rations. The option Field triple Fx is displayed for each field triple.
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Configure protective and warning fields
Defining contours and boundaries for protective field and warning field
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Fig. 8.6: Field editor with toolbar for field definition
% In the CONFIGURATION menu, click the field pair the protective and warning fields of which you want
to define.

% Click the [l button and define the contours and boundaries of the protective field.

NOTICE

Determine protective field size!

0 The protective field size is determined by the calculated safety distances and additional dis-
tances that you determined for the application assigned to the configuration bank.

NOTICE
If the protective field boundaries < 190 mm, object detection can be limited due to the measure-
ment error.

% When defining the protective field, take the additional distance Z,, to the protective field con-
tour into account (see chapter 6.2 "Stationary danger zone guarding").

% Click on the or #ﬁ button and define the contours and boundaries of the warning fields.
NOTICE

Right-click on the triple field in menu CONFIGURATION to calculate an auto-contour of the pro-
tective or warning field.

Q|

You can define the display options for the field editor in menu SETTINGS > Display options
field editor (see chapter 8.1.11 "SETTINGS").

Set the Triple Field Monitoring

% In the CONFIGURATION menu, click on the Field Triple Fx option whose protective and warning fields
you have set.

% Select the monitoring mode for the triple field in the Field Triple Monitoring list.
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Configure the signal parameters
% Click on Signal Parameters in the Configuration menu.
% Define the field quadruple switchover (Defining permissible field pair changeovers)
% Configure the signal outputs (see chapter 8.2.5 "Configuring signal outputs").

8.2.5 Configuring signal outputs

You can define which indication signals are transmitted to the individual indication signal connections.
% In the CONFIGURATION menu, select SIGNAL PARAMETERS.
% Assign the corresponding status signals to the free pins.
% Click the [Confirm] button.

All signal outputs are high active, i.e. logical 1 or +24 VV DC with an active signal.

8.2.6 Saving configuration
To save the changed configuration loaded in the software, you can transfer the configuration and settings
to the safety sensor or save them in a file on the PC.
Saving safety configuration as PDF file
% In the CONFIGURATION menu, click the [Create PDF file of safety configuration] button.
% Determine the storage location and the file name for the safety configuration.
% Click [Save].
= The safety configuration is saved as a PDF file.

Saving configuration and settings as file

% In the CONFIGURATION menu or in the SETTINGS menu, click the [Save configuration and settings to
file] button.

% Determine the storage location and the name of the configuration file.
% Click [Save].
= The configuration and settings are saved in the file format *.xml.

Saving configuration project as file

Click on [PROJECT] > [Save] in the FDT frame menu.
% Determine the storage location and the name of the configuration project file.
% Click [Save].

8.2.7 Transferring configuration project to safety sensor

The changes that you have made to the configuration only become effective when the changed configura-
tion project file is transferred to the safety sensor.

Prerequisites:
« The software and safety sensor are connected.
» The changed configuration project has been loaded in the software.
» The individual password for the access level Engineer is available.

+ Only users with the access level Engineer can transfer configuration data to the safety sensor. To
change the authorization level, press see chapter 8.2.8 "Selecting access level".

« If no individual password has been defined for the access level Engineer, use the preset default
password (safety).
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Alternatively, you can transfer a configuration project saved as a file on the PC directly to the
safety sensor.

% In the menu bar of the FDT frame menu, click the [download arrow] button. Alternatively: In the FDT
menu bar, select Device > Download parameters.

= The software asks for the access level and the password.

% Select the access level Engineer and enter the preset default password (safety) or the defined individ-
ual password.
Confirm with [OK].

% Before downloading the safety configuration, check whether you are connected to the correct safety
sensor.
Confirm the displayed safety notice with [Yes].
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Fig. 8.37: Check before safety configuration is downloaded

The software transfers the data of the configuration project to the safety sensor.

After successful transfer, the safety sensor immediately enters safety mode, i.e. the safety-related switch-
ing outputs switch on if all conditions are fulfilled.

» The configuration data is stored in the safety sensor.
* A copy of the safety configuration is stored in the configuration memory of the safety sensor.

The safety sensor can only be operated with a built-in configuration memory. If there is no con-
figuration memory built into the safety sensor, the OSSDs remain in the OFF state and the
safety sensor is prevented from starting up.

% Check the displayed signature.

% Confirm successful transfer of the safety configuration to the safety sensor with [OK].
The safety configuration has only been successfully transferred to the safety sensor when the confirma-
tion dialog is displayed during the download.
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Fig. 8.38: Confirmation Confirmation: safety configuration downloaded

The safety-related switching outputs will already have switched on if all conditions are fulfilled.

= The software has saved the configuration project in the safety sensor.

8.2.8 Selecting access level

With the device manager (DTM), you can change the authorization level of the user if necessary (see chap-
ter 4.1 "Authorization concept of safety sensor").

% Click in the DTM menu bar on the [Change authorization levell.
= The Change access level dialog box opens.

% Select the entry Engineer, Expert or Observer from the Authorization list and enter the specified indi-
vidual password or the preset standard password ( see chapter 8.1.11 "SETTINGS").
- Default password Engineer. safety
- Default password Expert: comdiag

% Confirm with [OK].

8.2.9 Reset safety configuration

The device manager (DTM) can be used to reset the safety configuration to the default configuration (one
protective function, no restart).

% In the DTM menu bar, click the [Reset safety configuration] button.

= Users with authorization level Engineer can also transfer the changed safety configuration to the safety
sensor (see chapter 8.2.7 "Transferring configuration project to safety sensor").
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9.1

9.2

9.3

9.4

9.5

Starting up the device

Switching on

Requirements for the supply voltage (power supply unit):
» Safe mains separation is ensured.
» Current reserve of at least 1 A is available.
% Switch on the safety sensor.

Aligning the safety sensor

Faulty or incorrect alignment may result in an operating fault!
% The alignment performed during start-up should only be performed by qualified personnel.

% Observe the data sheets and mounting instructions of the individual components.

% Align the safety sensor using an external spirit level.

Unlocking start/restart interlock

Premature unlocking of the start/restart interlock may result in serious injury!

' If the start/restart interlock is unlocked, the system can start up automatically.

% Before unlocking the start/restart interlock, make certain that no people are in the danger
zone.

The responsible person can restore the ON state of the safety sensor following process interruptions (due
to triggering of protective function, failure of the voltage supply).

% Unlock the start/restart interlock using the reset button.
The safety-related switching outputs are only enabled if you hold down the reset button for between
0.5sand4s.

Shutting down

Temporarily shutting down the machine with the safety sensor

When you shut down the machine with the safety sensor temporarily, you do not have to observe any more
steps. The safety sensor saves the configuration and starts again with the switch-on with this configuration.
Shutting down safety sensor and removing from machine

When you shut down the safety sensor and store it away for a later use, you must reset the safety sensor
to the factory settings.

Reset the safety sensor to the factory settings using the software:
% In the device manager (DTM) of the safety sensor, select the CONFIGURATION tab.
% Click the [Reset safety configuration] button.

Restarting

Restarting the machine with the safety sensor

If you have only shut down the system with the safety sensor temporarily and are restarting the system
without any changes, you can restart the safety sensor with the configuration that applied with the shut-
down. The configuration remains saved in the safety sensor.

% Perform a function check (see chapter 10.3 "Periodically by the operator").

Starting up machine with safety sensor after modification or reconfiguration

If you have performed significant changes on the machine or have reconfigured the safety sensor, the
safety sensor must be checked as with the initial start-up.

% Check the safety sensor (see chapter 10.1 "Before the initial start-up and following modifications").
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9.6 Set up replacement safety sensor in operation

Mount and align replacement safety sensor
% Mount the replacement safety sensor instead of the previous safety sensor and install the configuration
memory mounted in the previous safety sensor in the new safety sensor (see chapter 12.1 "Replacing
the device").
Transferring the configuration to the replacement safety sensor

The configuration stored in the configuration memory is automatically transferred to the replacement safety
sensor.
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10 Testing

% Always replace the safety sensors completely (including the configuration memory).

% For the tests, observe, if necessary, nationally applicable regulations.

% Document all tests in a comprehensible manner and include the configuration of the safety
sensor along with the data for the safety- and minimum distances in the documentation.

10.1 Before the initial start-up and following modifications

Unpredictable machine behavior during initial start-up may result in serious injury!
% Make certain that there are no people in the danger zone.

% Before they begin work, train the operators on their respective tasks. The training is the responsibility of

the operating company.
& Attach notes regarding daily testing in the respective national language of the operator on the machine
in a highly visible location, e.g. by printing out the corresponding chapter (see chapter 10.3 "Periodically

by the operator").
% Test the electrical function and installation according to this document.
Acc. to EN IEC 62046 and national regulations (e.g. EU directive 2009/104/EC), tests are to be performed

by competent persons in the following situations:
* Prior to initial commissioning
» Following modifications to the machine
 After longer machine downtime

» Following retrofitting or new configuration of the machine

% To prepare, check the most important criteria for the safety sensor using the following checklist (see
chapter 10.1.1 "Checklist for integrator — to be performed prior to the initial start-up and following modi-

fications"). Completing the checklist does not replace testing by a competent person!
Not until proper function of the safety sensor is ascertained may it be integrated in the control circuit of the

system.

10.1.1 Checklist for integrator — to be performed prior to the initial start-up and following modifications

Completing the checklist does not replace testing by a competent person!
% If you answer one of the items on the check list with no, the machine must no longer be op-

erated (see table below).
% EN IEC 62046 contains additional recommendations on testing protective devices.
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Tab. 10.1: Checklist for integrator — to be performed prior to the initial start-up and following modifications

Check: Yes |No n. a.
not ap-
plicable

Is the safety sensor operated acc. to the specific environmental conditions that
are to be maintained (see chapter 14 "Technical data")?

Is the safety sensor correctly aligned and are all fastening screws and connec-
tors secure?

Are safety sensor, connection cables, connectors, protection caps and com-
mand devices undamaged and without any sign of manipulation?

Does the safety sensor satisfy the required safety level (PL, SIL, category)?

Are the safety-related switching outputs (OSSDs) integrated in the downstream
machine control acc. to the required safety category?

Are switching elements that are controlled by the safety sensor monitored ac-
cording to the required safety level (PL, SIL, category) (e.g., contactors through
EDM)?

Are all points of operation near the safety sensor accessible only through the
protective field of the safety sensor?

Are the necessary additional protective devices in the immediate surroundings
(e.g., safety guard) properly mounted and secured against tampering?

If an undetected stay between the safety sensor and the danger point is possi-
ble: Is an assigned start/restart interlock functional?

Is the command device for unlocking the start/restart interlock mounted in such
a way that it cannot be reached from within the danger zone and so that the
complete danger zone can be seen from the installation location?

Has the maximum stopping time of the machine been measured and docu-
mented?

Is the required safety distance maintained?

Does interruption with a test object intended for this purpose cause the danger-
ous movement(s) to stop?

Is the safety sensor effective during the entire dangerous movement(s)?

Is the safety sensor effective in all relevant operating modes of the machine?

Is start-up of dangerous movements reliably prevented if the protective field is
interrupted with a test object intended for this purpose?

Was the sensor detection capability (see chapter 10.3.1 "Checklist — periodi-
cally by the operator") successfully checked?

Were distances to reflective surfaces taken into account during configuration
and no reflection bypasses subsequently detected?

Are notices for regular testing of the safety sensor legible to the operator and
are they located in a highly visible location?

Are changes to the safety function (e.g. protective field changeover) not easy
to achieve through tampering?

Are settings that could result in an unsafe state possible only by means of key,
password or tool?

Are there incentives that pose stimulus for tampering?

Were the operators instructed prior to starting work?
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10.2 To be performed periodically by competent persons

The reliable interaction of safety sensor and machine must be periodically tested by competent persons in
order to detect changes to the machine or impermissible tampering with the safety sensor.

Acc. to EN IEC 62046 and national regulations (e.g., EU directive 2009/104/EC), tests of elements which
are subject to wear must be performed by competent persons at regular intervals. Testing intervals may be
regulated by nationally applicable regulations (recommendation acc. to EN IEC 62046 months). 6 months

% Have all tests performed by competent persons.
% Observe the nationally applicable regulations and the time periods specified therein.

% Please refer to the checklist (see chapter 10.1 "Before the initial start-up and following modifications")
for preparation.

10.3 Periodically by the operator

The function of the safety sensor must be checked regularly (e.g., daily, on shift change, monthly or in an
even longer cycle) according to the following checklist. The frequency of the checks is determined by
means of the risk analysis performed by the operating company.

Due to complex machines and processes, it may be necessary under certain circumstances to check some
points at longer time intervals. Observe the classification in "Test at least" and "Test when possible".

Unpredictable machine behavior during the test may result in serious injury!
\ % Make certain that there are no people in the danger zone.
[

& Before they begin work, train the operators on their respective tasks and provide suitable
test objects and an appropriate test instruction.
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10.3.1 Checklist — periodically by the operator

ated (see chapter 10.1.1 "Checklist for integrator — to be performed prior to the initial start-

% If you answer no to any of the points on the checklist, the machine must no longer be oper-
up and following modifications").

Tab. 10.2: Checklist — regular function test by trained operators/persons

Test at least: Yes |No

Are safety sensor and connectors securely mounted and free of obvious signs of damage,
changes or tampering?

Were obvious changes made to access or entry possibilities?

Test the effectiveness of the safety sensor:
1. The LED 1 on the safety sensor must illuminate green (Display elements)

2. Interrupt the protective field using a suitable opaque test object (Leuze RSL400 test
rod or similar test object with 1.8 % diffuse reflectance at wavelength = 905 nm).

O—»O

Testing the protective field function with test body.

Use a test body with the set resolution. The test object should have a matt surface struc-
ture.

Does the LED 1 on the safety sensor illuminate constantly red while the protective field is
interrupted?

Tab. 10.3: Checklist — regular function test by trained operators/persons

When possible, test during running operation: Yes |[No

Protective device with proximity function: Protective device with approach function: during
machine operation, the protective field is interrupted with the test object — are the obvi-
ously dangerous machine parts stopped without noticeable delay?

Protective device with presence detection: Protective device with presence detection: the
protective field is interrupted with the test object — does this prevent operation of the obvi-
ously dangerous machine parts?
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11

11.1

11.2

Diagnosis and troubleshooting

What to do in case of failure?

Information on the device status and on diagnostics and troubleshooting for the safety sensor can be dis-
played as listed below:

LED indicator

Indicator elements make it easier to check for proper function and to find errors after the safety sensor is
turned on (see chapter 3.5 "Display elements").

App
Diagnostic data such as status and error information can be read out on a Bluetooth-capable end device
via the Bluetooth interface integrated in the safety sensor.

In the event of a fault, you can recognize the fault on the displays of the LEDs or via the displays in the app
and read a message. With the error message you can determine the cause of the error and initiate mea-
sures to rectify it.

Sensor Studio

The Sensor Studio configuration and diagnostics software can be used to display device status and diag-
nostic information.

NOTICE

If the safety sensor responds with an error display, you will often be able to eliminate the
cause yourself!

% Switch off the machine and leave it switched off.
% Analyze the cause of the fault using the diagnostics displays and rectify the fault.

% If you are unable to rectify the fault, contact the Leuze branch responsible for you or call the
Leuze customer service (see chapter 13 "Service and support").

Diagnostic displays RSL 200 app

To call up the diagnostic data, you need a Bluetooth-capable device and the RSL 200 app provided by
Leuze. The app can be used to display diagnostic data and change the communication settings.

The RSL 200 app is available for the iOS and Android operating systems and can be downloaded from the
Playstore (Android) or App Store (iOS).
Diagnostic data
The following diagnostic data can be displayed in the RSL 200 app:
» Device information
» Device type
* Device name
» Serial_No.
» Firmware version
* Device status
+ OSSD state
 State of start/restart interlock
* Warning field status
+ Bluetooth status
* Window soiling status
* Monitoring
* Window dirtiness rating
* Pin assignment
» Display active field triple
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11.3

* Technical data
» Device type
» Device name
« Serial_No.
* Part no.
* Number of available field triples
» Diagnosis
» Diagnostics list
» EventlLog
* Access list
+ Service file
« Communication settings
* TCP/IP settings
» UDP telegram settings
» EventlLog settings

Diagnostics messages

Leuze

The diagnostics displays consist of one letter plus four numbers, divided into classes consisting of letters

and the first number.

Tab. 11.1: Diagnostics classes:
Code letter Diagnostics Description
classes:
| Information * No OSSD switch-off
* Unhindered operation possible
U Usage Application error
External External error
Failure Internal device error.
» OSSD switch-off
» Self test unsuccessful
* Hardware error
P Parameter Discrepancy in configuration
Tab. 11.2: Diagnostic messages
Diagnose ID Diagnostic message Measure
U370 Input level at the electrical inputs is un- | Check the wiring of the safety sensor.
clear
U573 EDM fault at system start Check the wiring of the downstream re-
lays and that they are functioning cor-
rectly.
U574/U576 Switching fault, EDM at OSSD: external | Check the wiring of the downstream re-
relay does not switch off lays and that they are functioning cor-
rectly.
U575/U577 Switching fault, EDM at OSSD: external | Check the wiring of the downstream re-
relay does not switch on lays and that they are functioning cor-
rectly.
U581 Protection against manipulation triggered | Check if the optics cover is covered or if
the scanning range of the sensor is out-
side the maximum operating range.
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Diagnose ID Diagnostic message Measure
U583 Field triple changeover is not performed | Check the wiring and the changeover
in accordance with the specifications times of control inputs for the field triple
configured in the safety sensor: field triad | changeover (E1...E6)
not defined Signal for field triple activa-
tion is missing
us84 Field triple changeover is not performed | Check the changeover times of control
in accordance with the specifications inputs for the field triple changeover
configured in the safety sensor: field triad | (E1...E6) or that the parameter settings
not defined Switchover time exceeded in the configuration are correct
us85 Field triple changeover is not performed | Check the wiring of control inputs for the
in accordance with the specifications field triple changeover (E1...EB) or that
configured in the safety sensor: field triad | the parameter settings in the configura-
not defined Switching sequence not fol- | tion are correct
lowed in the correct order
us87 Motor speed outside tolerance Check the voltage supply.
U661 Safety-related switching outputs Check the wiring of the OSSDs.
(OSSDs) cannot be switched: Short cir-
cuit with 0 V, +24 VV DC or between
OSSDs
U791 Protection against manipulation triggered | Check if the optics cover is covered or if
at system start the scanning range of the sensor is out-
side the maximum operating range.
u8sg2 IO output monitoring indicates an error Check the wiring of the safety sensor.
P296 Higher access level required for the as- |Log on with a higher access level
signment of a machine ID
P414 Safety configuration is not compatible: Swap out the safety sensor or change
unknown EDM inputs the configuration. The safety sensor type
must match the type stored in the config-
uration memory or in the configuration
software
P415 Safety configuration is not compatible: Swap out the safety sensor or change
unknown monitoring mode of the field the configuration. The safety sensor type
triple changeover must match the type stored in the config-
uration memory or in the configuration
software
P416 Safety configuration is not compatible: Swap out the safety sensor or change
unknown field triple monitoring parame- | the configuration. The safety sensor type
ters must match the type stored in the config-
uration memory or in the configuration
software
P417 Safety configuration is not compatible: Swap out the safety sensor or change
unknown monitoring mode of the field the configuration. The safety sensor type
triple changeover must match the type stored in the config-
uration memory or in the configuration
software
P419 Safety configuration is not compatible: Swap out the safety sensor or change
unknown monitoring parameter for the the configuration. The safety sensor type
changeover order must match the type stored in the config-
uration memory or in the configuration
software
P422 Safety configuration is not compatible: Swap out the safety sensor or change
unknown field triple selection mode the configuration. The safety sensor type
must match the type stored in the config-
uration memory or in the configuration
software
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Diagnose ID

Diagnostic message

Measure

P424

Safety configuration is not compatible:
unknown parameter for manipulation
monitoring

Swap out the safety sensor or change
the configuration. The safety sensor type
must match the type stored in the config-
uration memory or in the configuration
software

P425

Safety configuration is not compatible:
unknown configuration of the output sig-
nals

Swap out the safety sensor or change
the configuration. The safety sensor type
must match the type stored in the config-
uration memory or in the configuration
software

P426

Safety configuration is not compatible:
unknown resolution

Swap out the safety sensor or change
the configuration. The safety sensor type
must match the type stored in the config-
uration memory or in the configuration
software

P427

Safety configuration is not compatible:
unknown parameter

Swap out the safety sensor or change
the configuration. The safety sensor type
must match the type stored in the config-
uration memory or in the configuration
software

P429

Safety configuration is not compatible:
unknown start/restart mode

Swap out the safety sensor or change
the configuration. The safety sensor type
must match the type stored in the config-
uration memory or in the configuration
software

P430

Safety configuration is not compatible:
unknown start mode

Swap out the safety sensor or change
the configuration. The safety sensor type
must match the type stored in the config-
uration memory or in the configuration
software

P431

Safety configuration is not compatible:
unknown restart mode

Swap out the safety sensor or change
the configuration. The safety sensor type
must match the type stored in the config-
uration memory or in the configuration
software

P607

Unable to unpack configuration file

Re-transmit the safety configuration to
the sensor or re-create the safety config-
uration.

P608

Unable to unpack configuration file

Re-transmit the safety configuration to
the sensor or re-create the safety config-
uration.

P609

Wrong CRC of the configuration file

Re-transmit the safety configuration to
the sensor or re-create the safety config-
uration.

P610

Wrong signature of the configuration file

Re-transmit the safety configuration to
the sensor or re-create the safety config-
uration.

P611

The configuration could not be read

Re-transmit the safety configuration to
the sensor or re-create the safety config-
uration.

P612/P613/P614

Safety test configuration incorrect

Re-transmit the safety configuration to
the sensor or re-create the safety config-
uration.
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Diagnose ID Diagnostic message Measure

P615-P620 Security check configuration: CRC error | Re-transmit the safety configuration to
the sensor or re-create the safety config-
uration.

P621-P626 Parameter description test faulty Create the safety configuration again

P629-P631

P633-P649

P627 Security check configuration: CRC error | Re-transmit the safety configuration to
the sensor or re-create the safety config-
uration.

P628 Security check configuration: Contour Re-transmit the safety configuration to

size incorrect the sensor or re-create the safety config-
uration.

P650 Machine ID not stated or wrong Enter the correct machine ID.

P651 Safety test configuration incorrect Re-transmit the safety configuration to
the sensor or re-create the safety config-
uration.

P652 Unknown operating mode Restart the sensor.

P653 The safety configuration is not compati- | Swap out the safety sensor or change
ble: The protective/warning field radius is |the configuration. The safety sensor type
too large. must match the type stored in the config-

uration memory or in the configuration
software

P654 Field triple changeover is not performed | Check the wiring of control inputs for the
in accordance with the specifications field triple changeover (E1...EB6) or that
configured in the safety sensor: field triad | the parameter settings in the configura-
not defined Field triple not defined tion are correct

P676 Safety test configuration in the sensor in- | Re-transmit the safety configuration to
correct the sensor or re-create the safety config-

uration.

P678 Safety test configuration in configuration | Re-transmit the safety configuration to
memory failed the sensor or re-create the safety config-

uration.

P747 The safety configuration is not compati- | Change the dimensions and contour of
ble: Protective/warning field radius too the protective field in the configuration.
small The minimum range of the protective

field must be observed.

P810 Safety test configuration incorrect Re-transmit the safety configuration to
the sensor or re-create the safety config-
uration.

P926 Parameter description: Value of a con- Create the safety configuration again

stant is missing

P927 Parameter description: Enum parameter |Create the safety configuration again
not defined

P928 Parameter description: Enum parameter |Create the safety configuration again
name not unique

P929 Parameter description: Enum parameter |Create the safety configuration again
is not permitted here

1660 Field triad changeover is not performed | Check the wiring of control inputs for the
in accordance with the specifications field triple changeover (E1...EB6) or that
configured in the safety sensor: no field |the parameter settings in the configura-
triple activated at system start tion are correct
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Diagnose ID Diagnostic message Measure
1719 Timeout of RES signal (acknowledgment | Check the wiring of the RES input. The
button, start/restart) time specifications for start/restart must
be observed

1825 Simulation mode has been activated The safety-related switching outputs
(OSSDs) have been switched off.

1826 Simulation mode has been deactivated Sensor is again in safety mode.
CAUTION! Be aware of potential hazards
which can occur when the machine is
started up!

1935 Life expectancy will soon be reached Replace the safety sensor with a new de-
vice.

1936 All errors deleted The safety sensor is in normal operation.

11004 Field violation due to glare Mount the safety sensor in such a way
that it is not exposed to any external light
sources in the scan level

11008 An error may have to be acknowledged | Press the reset button.

11009 Field triple selection is valid again Error during field triple selection has
been rectified; the signals are valid

11010 The signal at the restart input is valid Error at the restart input has been recti-

again fied; the signal is valid again.

11207 Optics cover is soiled Clean the optics cover as soon as possi-
ble. Sensor is still in safety mode.

11218 The temperature measured in the device | The temperature of the safety sensor is

is in the permissible range again in the normal range again

E1206 Optics cover is soiled Clean the optics cover.

F... The monitoring functions have detected |Create the service file and contact Leuze

an internal error. Customer Service.
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121

12.2

Care, maintenance and disposal

Replacing the device

If the test of the safety laser scanner or an error message indicates a defective safety sensor, replace the
device.

Only an instructed and competent person may replace the safety sensor.
The safety sensor is replaced in the following steps:
» Disconnect the defective device from the connection cables.
* Remove the configuration memory from the defective safety sensor.
« Install the configuration memory in the new safety sensor.

NOTICE

0 % Only configuration memories of the same variants (same item number of the safety sensor)

can be exchanged. If a configuration memory is installed in a device variant other than the
one in which it was installed in the delivery state or with which it was initially configured, the
configuration is not transferred and the OSSDs remain in the OFF state.

% If a pre-configured configuration memory is built into a brand-new, unconfigured safety sen-
sor, the safety configuration stored on the configuration memory is transferred to the safety
sensor and you can use the safety sensor after the restart without reconfiguration.

% If a brand-new, non-configured configuration memory is built into a pre-configured safety
laser scanner, the safety configuration stored in the safety sensor is transferred to the con-
figuration memory and you can use the safety sensor after a restart without reconfiguration.

% The safety laser scanner must only be operated when a valid configuration memory is built
into it.

% The configuration memory's cover must always be closed and the M3 screw tightened with a
tightening torque of 0.35 - 0.5 Nm to achieve the stated IP type of protection.

% Connect the new safety sensor.
% Check the safety sensor's configuration (see chapter 8.2 "Configuring the safety sensor").

% Check the safety sensor in accordance with the initial operation (see chapter 10.1.1 "Checklist for inte-
grator — to be performed prior to the initial start-up and following modifications").

% Set up the new safety sensor.

NOTICE
Safety sensor malfunction due to contamination and damage!
% Carry out all work in an environment that is as free of dust and dirt as possible.

% Do not touch any parts inside the device.
% The configuration memory must be replaced in a clean environment with little dust.

% Visually inspect the configuration memory including the installed seal. If damage is detected,
the configuration memory must not be reused and must be replaced.

Cleaning the optics cover

Clean the optics cover as required by the application-related load rating.

Use the RS4-cleantex cleaning cloths and an isopropanol-based cleaner to clean the optical dome.
The procedure for cleaning depends on the kind of contamination:

Soiling Cleaning

Particles, loose, scouring Vacuum without touching or blow away softly, oil-free
Wipe free in one swipe with cleaning cloth

Particles, loose, non-scouring Vacuum without touching or blow away softly, oil-free
or

Wipe free in one swipe with cleaning cloth
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Soiling Cleaning

Particles, sticking Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Particles, statically charged Vacuum without touching
Wipe free in one swipe with cleaning cloth soaked with cleaning
agent

Particles/drops, smearing Wet with cloth soaked in cleaning agent

Wipe free in one swipe with cleaning cloth

Water drops Wipe free in one swipe with cleaning cloth

Oil drops Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Fingerprints Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Scratches Change optics cover

NOTICE
0 The wrong cleaning agents or cloths will damage the optics cover!

% Do not use any scouring cleaning agents or scratching cloths.

NOTICE

fault of optics cover monitoring. After cleaning is complete, the safety sensor resets itself auto-
matically.

0 If cleaning takes longer than four seconds, e.g. with fingerprints, the safety sensor displays a

% Clean the entire optical dome.
% Soak cloth with cleaning agent.
% Wipe optics cover free in one swipe.

NOTICE

Internal monitoring of optics cover!
% The monitored area is dependent on the configuration and can be smaller than the entire

scanning range of 275°.

% On account of device safety, the internal monitoring of the optics cover monitors a range
that is larger than specified by the configured protective field.

Improper calibration of the optics cover may result in serious accidents!
| The optics cover may be calibrated only if it is as new, clean and scratch-free.

Calibration of a not as new, scratched or soiled window can impair the protective function of the
safety sensor.

12.3 Servicing
The device does not normally require any maintenance by the operator.
Repairs to the device must only be performed by the manufacturer.

% For repairs, contact your responsible Leuze subsidiary or Leuze customer service (see chapter 13 "Ser-
vice and support").

12.4 Disposing
% For disposal observe the applicable national regulations regarding electronic components.
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Service and support

Service hotline

You can find the contact information for the hotline in your country on our website www.leuze.com under
Contact & Support.

Repair service and returns

Defective devices are repaired in our service centers competently and quickly. We offer you an extensive
service packet to keep any system downtimes to a minimum. Our service center requires the following in-
formation:

* Your customer number

» Product description or part description

» Serial number or batch number

» Reason for requesting support together with a description

Please register the merchandise concerned. Simply register return of the merchandise on our website
www.leuze.com under Contact & Support > Repair Service & Returns.

To ensure quick and easy processing of your request, we will send you a returns order with the returns ad-
dress in digital form.
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14.1

Leuze electronic GmbH + Co. KG

Technical data

General specifications

Leuze

Tab. 14.1: Safety-relevant technical data

Type in accordance with EN IEC 61496 Type 3
SIL in accordance with IEC/EN 61508 SIL 2
Maximum SIL in accordance with EN IEC 62061 SIL 2
Performance level (PL) in accordance with PLd

EN ISO 13849-1

Category in acc. with EN ISO 13849-1 Cat. 3
Average probability of a failure to danger per hour |2x10% 1/h

(PFH,)

Mission time (T,,)

20 years (ISO 13849-1)

Repairs or the exchange of wear parts do not ex-
tend the mission time.

Tab. 14.2: Optical data

Laser class according to IEC 60825-1:2014 / EN
60825-1:2024 + A11:2021

Class 1

Wavelength 905 nm (infrared)

Impulse duration 6 ns

Maximum output power (peak) 25W

Pulse frequency of laser transmitter 96 kHz

Scan rate 40 scans/s, equal to 25 ms/scan

Scanning angle Max. 275°

Angular resolution 0.2°

Tab. 14.3: Protective field data

Safety sensor RSL 210 RSL 220 RSL 230
RSL 235

Number of field triples 1 8 32

Minimum adjustable range 50 mm

Detection range of the test object from the housing
edge

The detection capability is limited in the 0 mm to
50 mm range to increase availability.

Diffuse reflectance PF minimum

1.8 %

Tab. 14.4: Protective field range

Resolution [mm)]

Protective field range [m]

70

3.00

50

3.00
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Tab. 14.5:  Warning field data

Leuze

Safety sensor RSL 210 RSL 220 RSL 230
RSL 235

Number of field triples 1 8 32

Warning field range 0...15m

Object size 150 mm x 150 mm

Diffuse reflectance WF minimum Min.: 20

Tab. 14.6: Electrical supply

Voltage supply

24V DC (+20% / -30%)

Power supply unit/battery

Supply acc. to EN IEC 61558 with safe mains sepa-
ration and equalization for power outages of up to
20 ms acc. to EN IEC 61496-1.

Current consumption

< 300mA (use power supply unit with 1 A)

Power consumption

7 W with 24 V plus output capability

Switch-on current

Max. 1 A

Overvoltage protection

overvoltage protection with protected limit stop

Protective conductor

Connection required

Device connection

8-pin M12 connector (RSL 210, RSL 220)
12-pin M12 connector (RSL 230, RSL 235)

Connection socket for Ethernet/communication

4-pin M12 connector, D-coded (RSL 235)

Tab. 14.7: Inputs

Reset

+24 'V, dynamically monitored (0.12 s to 4 s)

Field triple changeover

RSL 220

Selection of 8 field triplets via 4 control inputs +24
V, dynamically monitored

RSL 230, RSL 235:

Selection of 32 field triplets via 6 control inputs +24
V, dynamically monitored

Tab. 14.8: Safety-related switching outputs

OSSD transistor safety-related switching outputs

2 safe PNP semiconductor outputs
Short-circuit proof, cross circuit monitored

Class (source) acc. to CB24| Edition 2.0.1

C2

Minimum Typical Maximum
Response time 75ms 1000 ms

(3 scans) (40 scans)
Switching voltage high active Us—-1.8V
Switching voltage low <3V
Switching current 85 mA
Cut-off frequency f 1 kHz
Load capacity Cy.q 10 nF

Cable length between safety sensor and load

see chapter 7.2 "Cable lengths depending on the
supply voltage"

Leuze electronic GmbH + Co. KG
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Test pulse width 200 ps 200 ps

Test pulse distance 24,6 ms 25ms 76,9 ms

therefore neither necessary nor permitted to use the spark extinction circuits recommended by
contactor or valve manufacturers (RC elements, varistors or recovery diodes), since these con-

ﬁ The safety-related transistor outputs perform the spark extinction. With transistor outputs, it is
siderably extend the decay times of inductive switching elements.

Tab. 14.9: Inputs and outputs

Input, min. input current I, 3 mA (at U)

Output, max. output current |, 50 mA

Signal definition:

High / logical “1” U -1.8V (U is the supply voltage of the device)

Low / logical “0” <3V

Tab. 14.10: USB connection

Type of interface USB 2.0
Connection type Type C
Transmission rate <12 Mbit/s
Cable length <5m
bonger cable lengths are possible using active ca-
es.

Tab. 14.11: Bluetooth

Frequency band 2400 ... 2483,5 MHz
Radiated transmitting power Max. 4.5 dBm (2.82 mW), Class 2

Tab. 14.12: Software

Configuration and diagnostics software Sensor Studio for Windows 11 or higher

Tab. 14.13:  General system data

Degree of protection IP 65 in accordance with IEC/EN 60529

Protection class [l in accordance with IEC/EN 61140

Ambient temperature, operation 0...+50°C

Ambient temperature, storage -20 ... +60 °C

Humidity DIN 40040, table 10, code letter E (moderately dry)
Height above standard elevation zero (operation) <3000 m

Interference rejection In acc. with EN IEC 61496-1 (type 4)

Vibration stress over 3 axes In acc. with IEC/EN 60068 Part 2 — 6, 10 — 55 Hz,

max 5 G, additionally acc. to IEC TR 60721 Part 4 —
5, class 5M1, 5 - 200 Hz, max 5 G

Continuous shocks over 3 axes (6 directions) In acc. with IEC/EN 60068 Part 2 — 29, 100 m/s?,
16 ms, additionally acc. to IEC TR 60721 Parts 4 —
5, class 5M1, 50 m/s?, 11 ms

Disposal Specialist disposal required
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Housing Diecast zinc, plastic

Standard version dimensions (ensure free space for |80 x 80 x 86 (W x H x D) in mm
connector with fixing and connection cable)

Weight of standard version Approx. 0.6 kg

Distance, beam level center to bottom housing edge | 60 mm

Tab. 14.14: Patents

US patents -

14.2 Dimensions

M5 (4x) 19,4
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All dimensions in mm
A Configuration memory
B USB connection
C Scanning plane
D Template

Fig. 14.1: RSL 210/220 dimensions
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14.3 Dimensioned drawings: Accessories
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Fig. 14.2: Mounting system BTU 500M

106,

All dimensions in mm

Fig. 14.3: BT 500M mounting adapter
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Fig. 14.4: BTP 500M protective bracket
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Fig. 14.5: BTX 500M-BTU800M adapter plate
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15 Order guide and accessories

Scope of delivery
* RSL 2xx safety laser scanner

Leuze

e Document: RSL 200 user information

« Self-adhesive safety

15.1 Type overview

Tab. 15.1: Safety laser scanner

Part no. Article Description

53802101 RSL210-S/08-M12 1 OSSD pair, 1 field triple, 4 outputs, protective field range
max. 3 m
Control connection: M12, 8-pin

Tab. 15.2: Spare parts

Part no. Article Description

50152639 RSL200-WIN Optics cover

50152640 RSL200-CONFIG Configuration memory

15.2 Accessories — connection technology

Tab. 15.3: Connection cables

Part no. Article Description

50135127 KD S-M12-8A-P1-020 Connecting cable M12, axial, 8-pin, A-coded, 2 m
50135128 KD S-M12-8A-P1-050 M12 connection cable, axial, 8-pin, A-coded, 5 m

50135129 KD S-M12-8A-P1-100 M12 connection cable, axial, 8-pin, A-coded, 10 m
50135130 KD S-M12-8A-P1-150 M12 connection cable, axial, 8-pin, A-coded, 15 m
50135131 KD S-M12-8A-P1-250 M12 connection cable, axial, 8-pin, A-coded, 25 m
Tab. 15.4: Interconnection cables

Part no. Article Description

50151103 KSS US-USB2-A-USB2-C-V1-020 USB 2.0 A - USB 2.0 C connection cable, 2 m

15.3 Accessories - mounting technology

Tab. 15.5: Mounting technology

Part no. Article Description

50152257 BTU 500M set Mounting system Laser scanner for vertical and horizontal align-
ment incl. mounting adapter

50152258 BT 500M Mounting adapter

50152259 BTP 500M Loop guard

50152260 BTX 500M- Adapter plate to BTUS800OM

BTU8S0OOM

50152261 BTU 500M Laser scanner mounting system for vertical and horizontal align-

ment

Leuze electronic GmbH + Co. KG

RSL210 89



Order guide and accessories

15.4 Other accessories

Leuze

Tab. 15.6: Specimen

Part no. Article Description
50145020 RSL400 test rod 50 | Specimen @50 mm
50145022 RSL400 testrod 70 | Specimen @70 mm
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16 Standards and legal regulations

In particular, the current version of the following national and international legal regulations apply for com-
missioning, technical tests and handling of safety sensors:

* Machinery directive 2006/42/EC

» Low voltage directive 2014/35/EU
« EMC directive 2014/30/EU

» Use of work equipment directive

« Directive on the restriction of the use of certain hazardous substances in electrical and electronic equip-
ment

+ OSHA 1910 Subpart O
 Vibration IEC/EN 60068-2-6
» Eye safety (measurement laser) IEC/EN 60825-1
« Safety regulations
» Accident-prevention regulations and safety rules
» Ordinance on Industrial Safety and Health and employment protection act
* Product Safety Law (ProdSG)
» Standards for risk assessment, e.g. g,
+ ENISO 12100
+ ENISO 13849-1, -2
IEC/EN 61508-1 to -7
EN IEC 62061
IEC/EN 60204-1
+ ENISO 13849-1
+ ENISO 13855
« ENIEC 61496-3
+ ENISO 3691-4
+ EN IEC 62046

16.1 Radio approvals

* Contains FCC ID: ASTBM78ABCDEFGH
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two condi-
tions:

» This device may not cause harmful interference.
+ This device must accept any interference received, including interference that may cause undesired
operation.
Responsible Party — U.S. Contact Information
Leuze electronic, Inc.
2510 Northmont Parkway, Suite N
Duluth, GA 30096

Phone: +1 470 508-3600
E-mail: info.us@leuze.com
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16.2

IT security

This chapter provides information on the safe operation of a safety laser scanner of the RSL 200 series
with regard to IT security. It covers various aspects, including recommendations for system configuration,
as well as instructions and support for avoiding system vulnerabilities.

Changing the default passwords

% Change the safety laser scanner's default passwords for the authorization levels Expert and Engineer
when the safety sensor is first put into operation.

Further information on changing passwords can be found in see chapter 8.1.11 "SETTINGS".

Deactivate Bluetooth
% Deactivate the safety sensor's Bluetooth interface if it is not used regularly (e.g. to connect the safety
sensor to the Sensor Studio configuration and diagnostics software or the RSL 200 app).
Physical access control
The operator must ensure that physical access to the safety sensor is restricted to authorized persons.

Network segmentation

The operator's network should be segmented into different zones. Each environment has its own subnet
and internal communication is only allowed based on a predefined allow list based network policy.

Zones according to IEC 62443

Systems are segmented into homogeneous zones by grouping the assets (logical or physical) with com-
mon security requirements. The security requirements are defined by Security Level (SL). The level re-
quired for a zone is determined by the risk analysis.

Zones have boundaries that separate the elements within the zone from the elements of other zones. Infor-
mation moves within and between zones. Zones can be divided into subzones, which define different secu-
rity levels (security levels) and thus enable defense in depth.

Conduits group the elements that enable communication between two zones. They provide security func-
tions that enable secure communication and allow zones with different security levels to coexist.
Mobile device management

An update strategy for mobile devices, e.g. smartphones and tablets (iOS and Android) that are connected
to the safety sensor via Bluetooth, is required. Always keep mobile devices up to date with the latest soft-
ware version.

The Leuze RSL 200 app must not be installed on a rooted device. A rooted device (Android or iOS smart-
phone/tablet) has been unlocked to adjust settings or install unapproved apps. Like jailbreaking an iPhone,
rooting a device can pose a security risk if pirated apps containing malware are uploaded.

Employees must report lost or stolen devices to management immediately. IT staff can remotely lock or
wipe missing devices to ensure system security.

Public USB ports are known to be a method of distributing malware and must not be used either. Since
data can easily be stored online or in the cloud, you should consider banning USB use altogether for maxi-
mum security.
Computer and software management

% Only install Leuze software on PCs managed by IT.
Avoid public Wi-Fi and USB ports!

Public Wi-Fi carries security risks and should be avoided for business purposes. Unsecured networks are
frequent gateways for malware that can endanger devices and access company data.

Public USB ports are known to be used to distribute malware and should also be prohibited. Since data can
easily be stored online or in the cloud, you should consider banning USB use altogether for maximum se-
curity.

Use passwords

Using lock screen passwords and strong passwords is an easy first step to increasing the security of de-
vices.
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Use antivirus software
Antivirus software is an indispensable tool in the fight against cybercrime.
% Use antivirus software to scan data and drives for viruses.
% Protect removable devices from infection with antivirus software.
Force updates

% Keep all software up to date with effective patch management. If software updates are not imple-
mented, you endanger the stability of your software environment. Experienced hackers are familiar with
system vulnerabilities and unpatched software makes it easy for them to penetrate your network.
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Declaration of Conformity
The RSL 200 series safety laser scanners have been developed and manufactured in accordance with ap-
plicable European standards and directives.

NOTICE

You can download the EC Declaration of Conformity from the Leuze website.
% Call up the Leuze website: www.leuze.com.

% Enter the type designation or part number of the device as the search term. The article num-
ber can be found on the name plate of the device under the entry “Part. No.”.

% The documents can be found on the product page for the device under the Downloads tab.
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